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Introduction
Chapter 1

Thank you for purchasing the MANTIS, a low dead-volume, non-contact liquid dispenser.
The unique design of this small machine minimizes dead volume and accepts pipette tip or
tube inputs.

Your MANTIS must be used in the manner described in this user’s guide. Any other use may
result in damage to your MANTIS or personal injury. FORMULATRIX, Inc. is not responsible
in whole or in part for any damages caused by: improper use, unauthorized alterations,
adjustments or modifications, failure to comply with the procedures outlined in the MANTIS
User’s Guide, or use of the products in violation of applicable laws, rules, or regulations.
Except as otherwise expressly provided in this user guide, any alteration, adjustment, or
modification to the products will void the product warranty.

Read, understand, and observe all safety information and instructions in this manual before
using your MANTIS. Please note specific safety requirements as explained in this user’s guide.
Failure to follow these instructions could result in serious personal injury.

Please save this guide for future reference and have it available to all operating personnel.

The MANTIS is manufactured to the current technical safety-relevant regulations.
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This icon denotes a caution and advises you of precautions to take.

This icon denotes a prohibited action.

This icon denotes a compulsory action and advises you of actions
you must take.

This icon denotes a caution relating to electric shock and advises you
of precautions to take.

This icon denotes a fire hazard and advises you of precautions to
take.

This icon denotes a warning.

Bold text denotes items you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes
parameter names.

bold

Text in this font denotes text or characters you should type from the
keyboard.

monospace

Symbols and Conventions

MANTIS User's Guide  |  Chapter 1: Introduction
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The safety recommendations in this guide are basic guidelines. If the lab where the
MANTIS is to be kept has additional safety guidelines they should be followed as well,
along with all applicable national and international safety codes.

FORMULATRIX products are CE (Conformité Européenne) Machinery, Low Voltage, and
EMC directive compliant. If necessary, request the official Declaration of Conformity
(DOC) from FORMULATRIX.

Safety Information
Chapter 2

Introduction

Only FORMULATRIX personnel are permitted to transport, assemble, or service the

Use only parts supplied or recommended by FORMULATRIX in this document or via
email.

Regulatory Compliance
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ü Read all safety and operating instructions before operating the MANTIS.

ü Do not place the MANTIS connections (power, waste lines, and communications
cables) where they could cause a safety hazard.

ü Do not place the product in a location where it may be subject to physical damage.

ü Ensure that all power connections to the product are properly grounded.

ü Do not remove the nameplate, or any warning, hazard, or Equipment Identification
labels.

ü Turn OFF power before inserting or removing power cables.

The MANTIS is a complex electromechanical instrument. Only persons with the proper
training should service or operate the product.

All facilities to the product must be disconnected before servicing, or injury may result
from the automatic operation of the equipment.

The proper precautions for operating electrical equipment must be observed.

Equipment Safety Guidelines

Mechanical Hazards

Electrical Hazards

Avoid damage to the power cables. Do not apply unnecessary stress, place heavy objects
on, or crush the cables or fire may occur.

Do not use extension cables unless approved by FORMULATRIX.

Switch off all power sources before removing connectors or electric shock may occur.

Arrange cables in accordance with the Technical Standard for Electric Properties and
Extension Rules or fire may occur.

MANTIS User's Guide  |  Chapter 2: Safety Information
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MANTIS

● Width: 354 mm or 13.9” (smaller without ACC or reagent holders)

● Height: Full Extension: 226 mm or 8.9” (not including pipette tip input)

● Height: No Extension: 193 mm or 7.6” (not including pipette tip input)

● Depth: 212 mm or 8.3”

Specifications
Chapter 3

Physical Dimensions

Front Side

226 mm

354 mm 212 mm
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Large Capacity Chip Changer (LC3)

● Width: 240 mm or 9.4”

● Height: Full Extension: 284 mm or 11.2”

● Height: No Carousel:  88 mm or 3.5”

● Depth: 240 mm or 9.4”

Front Side

MANTIS User's Guide  |  Chapter 3: Specifications

MANTIS with Large Capacity Chip Changer (LC3)

● Width: 449 mm or 17.7”  (MANTIS with LC3)

● Height: Full Extension: 284 mm or 11.2” (not including pipette tip input)

● Depth: 240 mm or 9.4”

Front Side

284 mm

240 mm 284 mm

449 mm

284 mm

240 mm
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The power supply for the system must meet or exceed electrical requirements of the
system to avoid damage and risk of fire.

● 110 V - 240 V, 50 Hz - 60 Hz, 50 W typical, 150 W max

● Standard or European electrical outlet

Computer Requirements

● Computer OS: Windows XP Home Edition SP3 32-bit/Windows 7 Home Basic
64-bit/Windows Vista 32-bit/Windows 8/Windows 10

● 1 open USB Port

● Dual Core 1 GHz processor

● At least 1 GB RAM

● 1 GB Hard drive space

● 768 pixels vertical minimum screen resolution

● .NET Framework 3.5

● FTDI 2.08.24

Electrical Requirements
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Extremely Low Dead Volumes

To minimize dead volume, the ingredient plugs directly into the microfluidic chip. Dead
volumes can be reduced to 6 µL by using pipette tips as ingredient reservoirs. This feature
is ideal for dispensing even the most precious samples.

Optional Chip Changer

MANTIS can automatically dispense up to six reagents, allowing you to dispense complex
plates and assay development experiments.

Small Footprint

They say good things come in small packages, and the MANTIS is no different. The
MANTIS is the smallest liquid handling robot made by FORMULATRIX and boasts one of
the smallest footprints on the market.

With a base that fits on a standard mouse pad, the MANTIS can fit in nearly any workspace
while remaining robot accessible for automation.

Continuous Flow Dispensing (optional)

With optional continuous flow, the MANTIS can pressurize an external bottle to dispense
liquids at a constant dispense speed. This dispensing method allows for filling seven times
faster (at a rate of 150 µL/second) than the previous MANTIS. This increased dispensing
speed is suitable for filling deep well blocks.

Overview
Chapter 4

Key Features
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Dual Wash Stations

The dual wash stations built into the MANTIS allow for easy sterilization during dispenses.
One station can be used for bleach or acceptable sterilization solutions for sterilization,
while the second station contains water for a final rinse.

The 3-step wash option is also available for a more thorough way to sterilize the MANTIS
chips using both water and wash solution. When you select this option, the MANTIS will
always wash its liquid lines with water, then wash solution, then rinse again with water.

Extended Plate Height Clearance for Deep Well Blocks

The dispense head of the MANTIS has clearance of up to 54 mm for dispensing into deep
well blocks.

Patented Microfluidic Dispensing Technology

At the core of the MANTIS is a patented microfluidic valve cluster that can measure and
dispense discrete volumes of liquid. Pressure and vacuum are used to open and close
each valve on the silicone valve cluster. This chip has two micro-diaphragms (100 nL / 500
nL or
1 µL / 5 µL depending on the chip option) that can fill and dispense as fast as 10 times per
second.

Integrated Ingredient Holders (optional)

The MANTIS comes fitted with removable ingredient holders that allow ingredients in 50
mL falcon tubes to sit safely during the dispense with no need for additional racks or risk
of tipping/spilling.

MANTIS User's Guide  |  Chapter 4: Overview
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MANTIS FRONT

Hardware Overview
Chapter 5

MANTIS Components

 Arms The MANTIS arms control the hand movements when
dispensing, loading and unloading chips.

Hand The hand holds the High Volume (HV), Low Volume (LV), High
Volume PFE, Low Volume PFE, or High Volume Continuous
Flow (CF) chip during general operations.

Chip Changer

Tube Holders

Plate Holder

Plate Clamp

Arm

Hand

MANTIS Front View
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MANTIS BACK

Chip Changers Using the chip changers, the MANTIS can automatically dispense up
to six reagents without user intervention. The chip changers are
compatible with High Volume (HV), Low Volume (LV), High Volume
PFE, Low Volume PFE, or High Volume Continuous Flow (CF) chips.

Plate Clamps Located on the lower-right of the plate holder, the plate clamps align
and secure the plate during the dispensing process.

Plate Holder The plate holder is compatible with almost all SBS plate types and
deep well blocks.

Tube Holder The tube holders are compatible with 50 mL Falcon tubes that are
ideal for large volume dispenses or frequently used reagents.

Waste Station The waste station is a station for the MANTIS to deposit waste
liquids.

Wash Stations The wash stations are where the MANTIS hold wash solutions and
water, used during the chip washing process. If you are running 3-
step Wash, wash solution should go in Wash Station 2, on the right
side of the MANTIS with the two chip stations. Otherwise, it can go in
Wash Station 1.

MANTIS User's Guide  |  Chapter 5: Hardware Overview

MANTIS Back View

Waste Station

Wash Station 1

Wash Station 2
USB Ports

Power Switch

Power Port
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USB Ports The USB ports are where you plug the USB flash drive into the
MANTIS. Two of these ports are included for future expansion. The
last USB port (located at the bottom) is used for connecting the
MANTIS hardware to your computer. The other end of the USB
cable should be plugged into your computer.

Power Switch The power switch turns the MANTIS on and off.

Power Port The power port is the area where you plug the power cable into the
MANTIS.

MANTIS User's Guide  |  Chapter 5: Hardware Overview
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Setting up the MANTIS for initial use means connecting all of the cables, setting up the
wash and waste tubes and installing the .NET framework as well as the FTDI drivers to
your computer.

To set up the MANTIS for initial use:

1. Connect the power cable to the MANTIS and plug it into an available outlet.

2. Make sure the power supply adapter is ON. Find the switch at the back of the
power supply adapter.

3. Connect the USB cable to the MANTIS and plug it into your computer.

4. Find the power switch at the back of the MANTIS and turn the MANTIS ON.

5. Once your computer detects the MANTIS, open Windows Explorer and locate
the MANTIS USB drive. Look for MANTIS-XXXX (the X’s represent your serial
number).

6. Double-click the MANTIS USB drive to display its contents.

● Double-click the Prerequisites folder. You will see the dotNET and
CDM20824_Setup.exe (FTDI driver). Install the dotNET driver and the FTDI
driver. You will be asked to restart your computer once you install the FTDI
driver.

● If you would like to have a shortcut for the MANTIS software on your
desktop, open the MANTIS folder, then open the Bin folder. Right-click the

MANTIS software icon , then point to Send to and select Desktop

(create shortcut).

Initial Setup
Chapter 6

Setting Up the MANTIS
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The shortcut is dependent upon the drive letter dictated by the MANTIS USB
connection. If at any time you disconnect the MANTIS and plug it into a
different USB port, the original desktop shortcut will no longer work.

Plate definitions are the files that define the geometry of the labware to the MANTIS.
Having a correct plate definition can be an important factor influencing the outcome of a
dispense. Four plate definitions (including one for a circular plate) come pre-installed with
the MANTIS software for your convenience, however, depending on the types of plates
you use you may need to add new plate definitions or modify existing plate types. You
must have at least one plate defined in MANTIS software before you can design a
dispense.

If you want to add a new plate to the plate library, please follow the instructions below
under Adding a New Plate Type on page 14.

If you want to modify an existing plate type in the plate library, please follow the
instructions under Modifying an Existing Plate Type  on page 20.

If you are defining or modifying the definition of a circular plate, please see Adding
Circular Plates to the Plate Type Library on page 23.

Adding a New Plate Type

Prerequisites

● You have prepared a reagent for the test drop.

● You have attached the tube input adapter on the chip. Ignore this prerequisite if
you are using a pipette tip.

● You have attached a chip to the MANTIS hand.

To add a new microplate to your plate library:

1. On the Tools menu, click Plate Type Editor.

2. Go to the File menu, select New, and then select Rectangular Plate. This will
start the new plate type wizard.

Adding Plate Types to the Plate Type Library

Note: You can use the keyboard keys to control the MANTIS arms
motion when adding or modifying plate types.

W: The key moves the MANTIS arms backward along the Y Axis.

S: The key moves the MANTIS arms forward along the Y Axis.

A: The key moves the MANTIS arms left along the X Axis.

D: The key moves the MANTIS arms right along the X Axis.

R: The key moves the MANTIS arms upward along the Z Axis.

F: The key moves the MANTIS arms downward along the Z Axis.

Note: To add a circular plate, see Adding Circular Plates to the Plate Type
Library on page 23.

MANTIS User's Guide  |  Chapter 6: Initial Setup
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3. On the wizard, select the Number of Wells from the list of typical SBS well
numbers or if you want to add a custom plate, select Custom and set the number
of rows and columns.

4. Place your new plate on the plate holder.

5. MANTIS needs to pick up a chip in order to proceed with the plate tuning
procedure. The reagent assigned to that chip can optionally be used to dispense
test drops while tuning your plate. Choose one of the following options:

● Select a reagent from the Select Reagent list to use that chip for the
plate tuning procedure. MANTIS will automatically attach the assigned
chip to the MANTIS hand.

● Select Unassigned Reagent if you want to use a reagent that has not
been assigned to a particular chip. When you use an unassigned reagent,
you must manually attach the desired chip to the MANTIS hand. Make
sure you have prepared a bottle or pipette tip containing the desired
reagent if you want to dispense test drops during the procedure.

6. Click and hold the prime button to prime the chip and then click Next.

Plate Type Editor Wizard
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7. Set the top-left well position by clicking the arrows, or use keyboard keys to
control the MANTIS hand to aim the nozzle tip at the top-left well. Then click the
Dispense button to dispense the test drop. If you are satisfied with the position,
click Next.

8. Set the bottom-left well position by clicking the arrows or use keyboard keys to
control the MANTIS hand to aim the nozzle tip at the bottom-left well. Then click
the Dispense button to dispense the test drop. If you are satisfied with the
position, click Next.

9. Set the top-right well position by clicking the arrows or use the keyboard keys to
control the MANTIS hand to aim the nozzle tip at the top-right well. Then click the
Dispense button to dispense the test drop. If you are satisfied with the position,
click Next.

10. Set the bottom-right well position by clicking the arrows or use the keyboard keys
to control the MANTIS hand to aim the nozzle tip at the bottom-right well. Then
click the Dispense button to dispense the test drop. If you are satisfied with the
position, click Next.

Note: For best results leave approximately 2 mm clearance between the top of
the plate and the chip nozzle.

Top-Left Position Settings
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11. Type the name of your plate and click Finish to complete the wizard and proceed
to the Plate type Editor for fine-tuning. Click Cancel to dismiss your changes.

12. Check the MANTIS dispense location settings: Click the Generated Well Map tab,
and then click on any of the blue underlined text location links. The MANTIS will
move its arms to the selected location (corner wells are the most indicative of any
errors).

New Plate Name

Generated Well Map Tab
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13. Optional: If you find that the geometry parameters determined by the wizard
require further adjustment, please follow the steps below:

a. Click the A1 Offset tab.

b. Click the Move To A1 Position button . The MANTIS will go to the A1
well location.

c. Use the Motion Control Pad at the lower right of the Plate Type Editor to
modify the A1 well position. Use the arrow keys to maneuver the MANTIS
hand to the A1 location of your plate. View the plate from both the side and
the front to ensure your center location is correct.

d. Click the Test Dispense button to dispense a test drop to the A1 well.
The drop should be in the A1 well.

e. Optional: Modify the Row Pitch and Column Pitch values in the Advanced
Options if the other well positions are not accurate.

14. Optional: You can modify the advanced options by clicking the Show Advanced
Options menu.

● Z-Drop determines the distance you would like MANTIS to move down into
each well before dispensing (default is zero).

● Min SD Pump determines the minimum enforced number of Small
Diaphragm pumps (default is zero). This forces the MANTIS to use the Small
Diaphragm for a larger portion of the dispense, if possible.

A1 Offset Tab Options
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● Velocity limits the arm movement speed to the specified percentage of the
maximum velocity. Default is 100%, which is recommended for most plate
types. 80% is recommended if you find that your 1536 well plate dispenses
causes the MANTIS arms to wobble.

● Row Pitch determines the distance between one well center point to another
in an adjacent row.

● Column Pitch determines the distance between one well center point to
another in an adjacent column.

● Height determines the height of the plate.

15. Optional: If you want to add coordinates for a drop well location on the plate
(useful for crystallography-type plates), follow the instructions below:

a. Go to the A1 Offset tab.

b. Optional: Click and hold the Manual Prime button until the chip begins

dispensing drops.

c. Click the Move To A1 Position button . The MANTIS will go to the A1
well location.

d. Click the Add Drop Location button .

Note: This feature is useful for preventing splashing when dispensing
into round-or conical bottomed plates. If splashing occurs, setting this
number to 5 or higher will greatly reduce or eliminate splashing.

MANTIS User's Guide  |  Chapter 6: Initial Setup

Advanced Options
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e. Use the Motion Control Pad at the lower right of the Plate Type Editor to
modify the drop position. View the plate from both the side and the front to
ensure your center location is correct.

f. Click the Test Dispense button to dispense a test drop. The drop should
be in the new drop location.

16. Go to the File menu in the Plate Type Editor wizard, click Save As, type a name
for your plate, and click Save.

OR

Go to the File menu in the Plate Type Editor wizard, and, click Save (Ctrl+S) to
save your changes.

You have successfully added a new plate type in the Plate Type Editor. To modify the
plate settings, go to the Modifying an Existing Plate Type section below.

Modifying an Existing Plate Type

Occasionally, you might want to modify the settings on an existing plate type in MANTIS
plate type library. You will need to follow the following steps if, for example, you find that
the drop location is inaccurate or when you want to adjust the row pitch and column pitch
values.

Prerequisites

● You have an existing plate type that you want to modify.

To modify an existing plate type:

1. Open the Tools menu, click Plate Type Editor.

2. Go to the File menu, click Open, then select a plate type and click Open again.
The details for the plate you chose populate the Plate Type Editor.

3. Modify the necessary parameters by clicking the Show Advanced Options menu.

● Z-Drop determines the distance you would like MANTIS to move down into
each well before dispensing (default is zero).

● Min SD Pump determines the minimum enforced number of Small Diaphragm
pumps (default is zero). This forces the MANTIS to use the Small Diaphragm for
a larger portion of the dispense, if possible.

● Velocity limits the arm movement speed to the specified percentage of the
maximum velocity. Default is 100%, which is recommended for most plate
types. 80% is recommended if you find that your 1536 well plate dispenses
causes the MANTIS arms to wobble.

● Row Pitch determines the distance between one well center point to another in
an adjacent row.

● Column Pitch determines the distance between one well center point to
another in an adjacent column.

● Height determines the height of the plate.

Note: This feature is useful for preventing splashing when dispensing
into round-or conical bottomed plates. If splashing occurs, setting this
number to 5 or higher will greatly reduce or eliminate splashing.

MANTIS User's Guide  |  Chapter 6: Initial Setup
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4. To modify the A1 dispense location:

a. MANTIS needs to pick up a chip in order to proceed with the plate tuning
procedure. The reagent assigned to that chip can optionally be used to
dispense test drops while tuning your plate. Choose one of the following
options:

● Select a reagent from the Select Reagent list to use that chip for the
plate tuning procedure. MANTIS will automatically attach the assigned
chip to the MANTIS hand.

● Select Unassigned Reagent if you want to use a reagent that has not
been assigned to a particular chip. When you use an unassigned reagent,
you must manually attach the desired chip to the MANTIS hand. Make
sure you have prepared a bottle or pipette tip containing the desired
reagent if you want to dispense test drops during the procedure.

b. On the A1 Offset tab, click and hold the Manual Prime button until the

chip begins dispensing drops.

c. Click the Move To A1 Position button . The MANTIS will go to the A1
well location.

d. Use the Motion Control Pad at the lower right of the Plate Type Editor to
modify the A1 well position. Use the arrow keys to maneuver the MANTIS
hand to the A1 location of your plate. View the plate from both the side and
the front to ensure your center location is correct.

e. Click the Test Dispense button to to dispense a test drop to the A1 well.
The drop should be in the A1 well.

MANTIS User's Guide  |  Chapter 6: Initial Setup

Advanced Options
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5. Check the MANTIS dispense location settings: Click the Generated Well Map tab,
and then click on any of the blue underlined text location links. The MANTIS will
move its arms to the selected location (corner wells are the most indicative of any
errors).

MANTIS User's Guide  |  Chapter 6: Initial Setup

A1 Offset Tab Options

Generated Well Map Options
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6. If you want to add coordinates for a drop location on the plate (useful for
crystallography-type plates), go back to the A1 Offset tab, click the Add Drop
Location button      . Then repeat the steps you took to define the A1 well location.

7. Go to the File menu in the Plate Type Editor wizard, click Save As, type a name
for your plate, and click Save.

OR

Go to the File menu in the Plate Type Editor wizard, and, click Save (Ctrl+S) to
save your changes.

Prerequisites

● You have the microplate data sheet that came with your plate.

● You have prepared a reagent for the test drop.

● You have attached the circular plate on the plate adapter.

● You have attached a chip to the MANTIS hand.

To add a circular plate to your plate type library:

1. Go to the Tools menu and select Plate Type Editor.

2. Go to the File menu, point to New, and then select Circular Plate.

3. Click the Lock Plate Clamp button .

4. Place your circular plate with the plate adapter on the MANTIS plate holder.

5. Type the name of your plate in the Plate Type Name.

6. On the Plate Parameters tab, select the number of wells your plate contains from
the Number of Wells list.

Adding Circular Plates to the Plate Type Library

Note: You can use the keyboard keys to control the MANTIS arms
motion when adding or modifying plate types.

W: The key moves the MANTIS arms backward along the Y Axis.

S: The key moves the MANTIS arms forward along the Y Axis.

A: The key moves the MANTIS arms left along the X Axis.

D: The key moves the MANTIS arms right along the X Axis.

R: The key moves the MANTIS arms upward along the Z Axis.

F: The key moves the MANTIS arms downward along the Z Axis.

MANTIS User's Guide  |  Chapter 6: Initial Setup
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7. To set the plate’s center point:

a. Optional: Click and hold the Manual Prime button  until the chip begins

dispensing drops.

b. Type the Center Point Location of the X, Y, and Z axis in the available boxes.

Then, click the Move to Specified Center Position button to check the

location.

c. Use the Motion Control Pad at the lower right of the Plate Type Editor to
modify the A1 well position. Use the arrow keys to maneuver the MANTIS
hand to the A1 location of your plate. View the plate from both the side and
the front to ensure your center location is correct. View the plate from both
the side and the front to ensure your center location is correct.

d. Click the Set Current Position as A1 button once you are satisfied with
the position.

e. Click the Test Dispense on Center On A1 button to dispense a test drop.
The drop should be at the center position of your plate.

8. To set the A1 dispense location:

a. Optional: Click and hold the Manual Prime button until the chip begins
dispensing drops.

b. Type the A1 Dispense Location of the X, Y, and Z axis in the available boxes.

Then, click the Move to Specified Center Position button .
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c. Use the Motion Control Pad at the lower right of the Plate Type Editor to
modify the A1 well position. Use the arrow keys to maneuver the MANTIS
hand to the A1 location of your plate. View the plate from both the side and
the front to ensure your center location is correct. View the plate from both
the side and the front to ensure your center location is correct.

9. Select either Clockwise or Counter Clockwise as the direction you would like the
MANTIS to dispense around the plate.

10. Set the well naming convention by typing a number in the Repeat numbering
every wells box. For example, if you type ‘6’, then the MANTIS will name the first
well A1, and after well A6 it will start naming wells with B1 until B6, and so on.

11. Check the MANTIS dispense location settings: Go to the Generated Well Map
tab, and then click Move to Position button. The MANTIS will move its arms to the
related location. If the locations are inaccurate, repeat steps 7 through 11.
Otherwise, proceed to step 12.

12. Go to the File menu in the Plate Type Editor wizard, click Save As, type a name
for your plate, and click Save.

OR

Go to the File menu in the Plate Type Editor wizard, and, click Save (Ctrl+S) to
save your changes.
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There are two ways to add reagents to the MANTIS memory: via the Reagent List or
during Dispense List creation.

● The Reagent List is a list of reagents stored in the MANTIS software's memory to
be used at any time, in any dispense list.

● A Dispense List is a list of reagents to be used in a particular plate dispense.

To add stock reagents to the reagent list:

1. Go to the Tools menu, and click Reagent List.

2. Type the reagent's name in the blank row.

3. Continue adding reagents to new rows.

4. When you’re done, click OK.

Adding Stock Reagents to the Reagent List

Note: You cannot rename the reagent after you save it to the Reagent List.

Note: MANTIS will always use the latest saved settings of each reagent in the
Reagent List for different dispenses, unless you are modifying it as needed. The
reagent settings in Reagent List will be updated if you modify or load the Reagent
Configurations. For more information, see Creating and Using Reagent
Configurations on page 55.

Reagent List Dialog Box
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If the MANTIS is unable to smoothly pick the chip up from the chip port or your dispense
locations are no longer accurate, you may need to tune the chip port position.

Prerequisites

● You have removed the chip from the MANTIS hand.

● The chip is loaded on the chip port that you wish to calibrate.

To calibrate the chip port position:

1. On the Chip Changer menu, click Tuning.

2. Follow the on-screen instructions.

Continuous Flow chips must be calibrated whenever you want to use them with reagents
that have not already been calibrated for continuous flow use. Continuous Flow chip
calibration determines the amount of fluid dispensed per second.

To calibrate a Continuous Flow chip:

1. Go to the Tools menu and select Continuous Flow Calibration.

2. Next to Reagent, select the reagent you want to use with the Continuous Flow
chip.

3. Next to Chip, select Continuous Flow.

4. Next to Dispense Time, type the number of seconds you want the MANTIS to
dispense the reagent for. If you plan to dispense 200 µL, 1 second is enough. For
a 650 µL dispense, you should run a 3 second test. Type in fractions of a second
like 0.5 second or less if you'd like to calibrate for smaller volumes.

5. Follow the on-screen instructions.

Calibrating the Chip Port Positions

Calibrating Continuous Flow Chips
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Default Volume and Tubing Length Recommendation

The following values for your chip input settings are a good starting point to design your
dispense for the first time, but may require some changes depending on your application
and length of tubing. It is recommended for you to cut your input tubing to a length of 45
cm.

All chip input settings can be configured from the Input Control panel. Click the Input

button to display the Input Option dialog box, and then specify all the chip input

settings as needed. If you are using a tube, refer to the default values under the Tube
Input Source Type section. If you are using a pipette tip, see the Pipette Tip Input Source
Type section.

Tube Input Source Type

Input Source Type Default volume values for tube input source (45 cm)

Chip Type Low Volume High Volume
Low

Volume PFE
High

Volume PFE
High

Volume CF

Prime Volume (µL) 100 200 100 200 250

Pre-Dispense Volume
(µL)

0.6 6 0.6 6

Recovery Volume (µL) 100 200 100 200

Wash Volume 1 (Station
1)

100 200 100 200

Wash Volume 2 (Station
2)

100 200 100 200

Wash Volume 3 (Station
3)

100 200 100 200

Tube - Low Volume Chip Type
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Pipette Tip Input Source Type

Input Source Type Default volume values for pipette tip input source

Chip Type Low Volume High Volume
Low Volume

PFE
High Volume

PFE

Prime Volume (µL) 6 16 6 16

Pre-Dispense Volume
(µL)

0.6 6 0.6 6

Recovery Volume (µL) 6 16 6 16

Wash Volume 1 (Station
1)

6 16 6 16

Wash Volume 2 (Station
2)

6 16 6 16

Wash Volume 3 (Station
3)

6 16 6 16

Note: We provide these screenshots for general reference. The default values
recommendation varies, depending on the input source type and chip type
selected.

Pipette Tip - Low Volume PFE Chip Type
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The MANTIS control software is made up of three main panels and a status bar.

Software Overview
Chapter 7

Main Software Overview

MANTIS Interface
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SECTION 1: DEVICE CONTROL PANEL

Section 1 is the top section of the Device Control panel. This is where you execute
commands in the MANTIS hardware using the buttons at the top, and view information
about your plate definition, the total volume per well (µL) and number of plates to be
dispensed. For more information, see Device Control Panel on page 32.

SECTION 2: INPUT CONTROL PANEL

Section 2 is the Input Control Panel. Use this panel to assign reagents to chip stations, run
the wash, prime, and reagent recovery processes, and tell the MANTIS whether you are
using Low Volume (LV), High Volume (HV), High Volume PFE, Low Volume PFE, or High
Volume Continuous Flow (CF) chips. For more information, see Input Control Panel on
page 35.
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Input Control Panel

Dispense Setting Tab
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SECTION 3: DISPENSE LIST DESIGNER

Section 3 is the Dispense List Designer. A dispense list is a list of reagents that will be
dispensed to a plate. On the left is where a list of your reagents appear, and on the right is
a visual representation of your plate. For more information, see Dispense List Designer on
page 41.

STATUS BAR

The Status Bar shows you what's going on with your MANTIS. For more information, see
Status Bar on page 43.

The Device Control panel provides access to controls for operating the MANTIS device.
You will use it when you have designed a dispense and need to assign reagents to chips,
or want to execute or pause a dispense.

The Device Control Panel is divided into four areas:

● Device Control Buttons

● Dispense Setting Tab

● Valve Control Tab

● Input Control Panel

Device Control Panel

Dispense List Designer
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Device Control Buttons

The buttons at the top of the device control panel execute different actions on the
MANTIS.

Dispense Setting Tab

The Dispense Setting tab allows you to
see and configure the Plate Definition
and the Total Volume per well (µL) of a
reagent. You can change the plate by
clicking on the name of the plate and
selecting a new plate from the list.
Note that you can only change
between plates with the same number
of wells.

The Total Volume per Well field is
populated only if every well has the
same total volume.

The Number of Plates is where you specify the desired number of plates to be dispensed
— it is typically used for running a multi-plate dispense with a single dispense list.
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Clicking the Run Dispense button starts the plate dispense. This button
changes to a pause button when clicked.

Clicking the Run Dispense with Protocol button starts the plate dispense
using the saved protocols available.

–
The Skip Dispense button tells the MANTIS to skip to the next reagent on
the dispense list (not visible for ACC MANTIS).

The Stop button stops the dispense.

–
The Home button homes the MANTIS motors, which can be useful if the
MANTIS is not dispensing as precisely as normal. When the LC3(s) is attached,
the home button can also home LC3 motors.

–
The Move to Idle Position button moves the MANTIS arms and hand to the
rest position.

The Move to Install Chip Position button extends the MANTIS arms and hand
so that you can more easily place the chip into place.

The Move to Install Input Position button moves the MANTIS arms and hand
to a position that enables you to easily attach the pipette tip or input tube to
the chip input.

Dispense Setting Tab
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Valve Control Tab

The Valve Control tab provides a visual representation of the microfluidic chip. Inside the
microfluidic chip is a valve cluster that controls liquid circulation. This valve cluster has two
micro-diaphragms, 0.1 µL (small) and 0.5 µL (large) in the low volume chip and 1 µL (small)
and 5 µL (large) in the high volume chip.

Both chips have two valves: fill and output. The graphic display allows you to manually
open (green) and shut (red) the valves by clicking on the representative area.

Plate Clamp

The plate clamp toggle is located below the microfluidic display. Its main function is to
lock and align your plate when you run the dispensing process so that the plate does not
move. The plate clamp is automatically active (green) when you run the dispensing
process and is inactive (red) after the dispensing process is done. The plate clamp is
pneumatic. Changing its state will activate the pump for a few seconds in order to actuate
it.

Air Pump

The air pump toggle is located next to the plate clamp toggle. Its function is to turn the air
pump on and off. The air pump provides adequate pressure and vacuum for the MANTIS
to run the dispensing, priming, and washing processes. Red indicates that the air pump is
inactive, and green indicates that it is active.

When you run the dispensing process, it takes two seconds (by default) for the air pump to
start. The air pump will need to stabilize the pressure and vacuum before the MANTIS runs
the dispensing process.

P/V

The Pressure and Vacuum toggle turns on and off the pressure in the bottle. A Continuous
Flow (CF) chip needs to be on the hand for the bottle to be pressurized. Green indicates
that the vacuum is active, and red indicates that the pressure is active. The Pressure and
Vacuum toggle is available only if you are using the Continuous Flow (CF) chip for
dispensing.
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The Input Control panel is represented by the image of the MANTIS at the bottom of the
Device Control panel. This is where you will tell the MANTIS which chips are connected to
specific reagents, run priming and washing processes, and execute the reagent recovery
process.

You can assign a reagent to a chip location by dragging the name of the reagent from the
Dispense List to the text box next to the chip number or the chip's location on the image of

the MANTIS. OR click the Assign To Input button to assign all reagents in the Dispense

List at once. You can then click the Mass Update Input button or the Input

button next to every reagent name box to change the input source type (tube or
pipette tip), chip type (Low Volume, High Volume, Low Volume PFE, High Volume PFE, or
High Volume Continuous flow), and configure the prime volume, wash volume, recovery
volume, and pre-dispense volume. To move all the unassigned inputs to the Dispense List,

you can click next to the Mass Update Input button. If you want to configure all of the

input settings, click the Configure All Input Settings button .

Understanding the Input Control Panel

Input Toolbar. The Input Toolbar provides you with seven dedicated buttons to perform
specific MANTIS operations, explained below.

Input Control Panel

Auto Prime

Clicking the Auto Prime button primes the chip with a fixed amount
of reagent, controlled by the Input Option settings. Priming brings
reagent through the chip so that when you begin a dispense the
chip is not dispensing air.

Manual Prime
Clicking the Manual Prime button will prime the chip until you stop
pressing the button.

Input Control Panel

MANTIS User's Guide  |  Chapter 7: Software Overview



36

Besides the above buttons, MANTIS also provides you with the two check bottle leak
buttons, which only appear when Continuous Flow is active.
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Prime All
Inputs

Clicking the Prime All button will prime every chip that has a reagent
listed in the Reagent Input Field.

Wash Input
Clicking the Wash Input button will wash the chip currently stationed
at the MANTIS hand.

Wash All
Inputs

Clicking the Wash All Inputs button will wash every chip that has a
reagent listed in the Reagent Input Field.

Recover
Input

Clicking the Recover Input button runs the reagent recovery process
on the chip currently stationed at the MANTIS hand. Recovering a
reagent will return most of the liquid in the chip and tubing to the source
container.

Recover All
Inputs

Clicking the Recover All Inputs button runs the reagent recovery
process on every chip that has a reagent listed in the Reagent Input
Field. Recovering a reagent will return most of the liquid in the chip and
tubing to the source container.

Bottle Leak Buttons

Check Bottle
Leak on

MANTIS Arm

Clicking the Check Bottle Leak on MANTIS Arm button enables
you to check any possible leaking pressure for a particular bottle
on the MANTIS arm.

Check All
Bottle Leak

Clicking the Check All Bottle Leak button enables you to check
any possible leaking pressure for all bottle(s) on the MANTIS arm.
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Device View. Device View displays the MANTIS hardware in use. In the image displayed
above, chip 1 is on the MANTIS hand. Double-clicking one of the chips will cause that chip
to be picked up by the MANTIS hand. Double-clicking a second time will return the chip
from the MANTIS hand to the chip changer station. In the image above, you will also see
the LC3 attached on the left side of the MANTIS. It will only appear if you have the LC3
instrument in your system.

To add a reagent from the Dispense List to the Device View, drag it from the Dispense List

to the reagent's chip changer station. OR click the Assign To Input button to assign
all reagents from the Dispense List at once.

Input. The Input tells you which reagent is assigned to which chip station. To the right of
each reagent input field is a symbol or an abbreviation that represents the type of chip
attached to that chip station. Options include:

You can see the status of your input through the Input Status box, whether it is defined in
the

Dispense List or not. This means that your input has been properly defined in the
dispense list. You should check and define your reagent in the Dispense List if you find

this in your Input Status box.

To move the chips between inputs, you can drag and drop the chips on the Input panel.
The chip information will also be automatically updated.

LV Low Volume Chip

HV High Volume Chip

HVP High Volume Chip PFE

LVP Low Volume Chip PFE

≈ High Volume Continuous Flow Chip

Note: Before you drag and drop the chip on the Input panel, make
sure that you move the chip on the chip changer first.

Drag and Drop to Move the Chips
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Input Button

Clicking the Input button enables you to change the input source
type (tube or pipette tip), chip type (Low Volume, High Volume,
Low Volume PFE, High Volume PFE, or High Volume Continuous
Flow), and configure the prime volume,  wash volume, and
recovery volume, and pre-dispense volume.

HV with the Pipette Input Source

HV Continuous Flow Options
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Reagent Name. Contains the name of the reagent.

Chip Serial Number.* Contains RFID chip serial number.

Chip Type. Click the Chip Type list and select the desired chip type (Low Volume, High
Volume, Low Volume PFE, High Volume PFE, or HV Continuous Flow) that you want to
use. The actual chip should match the chip type selected.

Input Source Type. Click the Input Source Type list and select the desired input source
type (Tube or Pipette Tip) for your experiment. The recommended length for tubing is 450
mm. The HV and LV chips use a slightly different tubing. The HV tubing is green while the
LV tubing is white. Please make sure you have matched the tube and chip accordingly.

Prime Volume. Type the desired volume to fill your tubing and/or chip channels in the
Prime Volume box. The MANTIS typically primes the chip only once at the beginning of
the dispense to make sure all of the liquid channels are full. You will know the channels
are full once reagent starts dispensing from the chip nozzle.

Pre-Dispense Volume. Type the desired reagent volume that you would like to dispense
to waste before dispensing into your plate in the Pre-Dispense Volume box.

Recovery Volume. Type the desired reagent volume that you would like to return to your
source container (pipette tip or tube) in the Recovery Volume box.

Wash Step(s). Select the wash steps you want to execute.

● 1 (Station 1) — This option enables MANTIS to wash the chip using only the wash
liquid available in Wash Station 1.

● 2 (Station 1-2) — This option enables MANTIS to wash the chip using liquid in Wash
Station 1 and rinse the chip using wash liquid in Wash Station 2.

● 3 (Station 1-2-1) — This option enables MANTIS to do the 3-step wash. You must fill
the Wash Station 1 with water and Wash Station 2 with wash solution. MANTIS will
wash the chip using water in the Wash Station 1, then wash solution in Wash Station 2
and rinse the chip using water in Wash Station 1. For more information, see Sterilizing
Mantis Chips on page 108.

Wash Volume 1 (Station 1). Type the desired wash volume to use during the chip cleaning
process.

Wash Volume 2 (Station 2). Type the desired wash volume to use during the chip cleaning
process.

Wash Volume 3 (Station 1). Type the desired wash volume to use during the chip cleaning
process.

Recovery Duration.** Type the recovery duration in milliseconds in the Recovery Duration
box.

Double Recovery.** Set this option to True to enable two reagent recovery cycles after
dispensing with the Continuous Flow chip.

Delay Between Recovery.** Type the delay time between two reagent recoveries in
milliseconds in the Delay Between Recovery box.

Pause for Reagent Refill.*** Enable this option to make the MANTIS pause during the
dispense to refill the pipette tip.
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Reagent Volume.*** Type the reagent volume that will cause MANTIS to pause for reagent
refill. This option is available if you enable the Pause for Reagent Refill option. This option
allows you to use a pipette tip with reagent volumes exceeding the tip capacity. For
example, if you want to deliver 20 μL into every well of a 96 well plate while using 1 mL tip
as input source (total 1920 μL) you can set the reagent volume to 950 μL. That will cause
the MANTIS to pause for a top-up roughly half-way through the plate. Filling the tip with
10% extra sample is advised to prevent the reagent from running out.

Restore Default Values. Click the Restore Default Values button to restore the default
values for all chip input settings.

Date of Manufacture.* Contains the chip’s manufacturing date.

Chip Dispense History tab.* Contains information about the chip usage and dispense
process.

*Available for MANTIS with RFID.

**Available when you use the High Volume Continuous Flow chip.

***Available when you use the pipette tip input source.

Mass update Input

If you have the same chip and input type for all chip
stations, you do not need to configure each chip position
individually. Click the Mass Update Input button to make
changes to multiple chip stations at once.

Note: The reagent tracking works only during a dispense, and not between runs.
For example, if you filled the tip with 1000 μL, then executed a dispense delivering
750 μL, after the dispense the reagent volume will remain set to 1000 μL in the
software.

Note: You must calibrate each reagent for continuous flow. If you have not set
up a reagent for continuous flow, click the Calibrate for Continuous Flow
button and follow the on-screen instructions.

Mass Update Input Options
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The Dispense List Designer is where you create or import a dispense list and plate
dispense design. At the left of the Dispense List Designer is the Dispense List, which is a
list of reagents to be used in a particular plate dispense. At the right of the Dispense List is
a graphical view of your plate design. This area is where you design the dispense using the
reagents in your Dispense List.

Dispense List Buttons

There are buttons along the top of the Dispense List that allow you to create a new
dispense list, open an existing dispense list, add a new reagent to the dispense list, delete
a reagent on the dispense list, duplicate a reagent on the dispense list, and increase or
decrease the dispense priority of an item.

Reagent Information Box

At the bottom of the dispense list is a box of information that changes based on which reagent
is highlighted in the dispense list. This table shows you the reagent's name, the dispense
location, the reagent's barcode (if any), the dispense volume, the prime volume, the
pre-dispense volume, the total volume, and the supported continuous flow chips. You can
change these items if they are shown in bold text. To see your options, click anywhere in the
text field of the bold text, then click the down-arrow to display the options.
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Dispense List Designer

You can also access, modify and change the Input configuration through the
Configuration All Input Settings button .

Scan All RFID Chips
If your MANTIS is equipped with RFID, click the Scan All
RFID Chips button to scan all RFID chips at once, see
MANTIS Radio-Frequency Identification (RFID) on page 95.

Dispense List Buttons

Reagent Information Box
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Plate Designer

The Plate Designer is used to design the plate dispense. You can click on a single well to
select it; click and drag to select an area of wells, or hold down the Ctrl key on your
keyboard while clicking wells to select non-adjacent wells.

Plate Designer Toolbar Buttons

The Plate Designer has its own toolbar buttons that allow you to switch between Designer
View, Summary View, and Volume Error View; change the volume fill type, undo and redo
design actions; change the fit of the virtual plate on your screen; and edit a dispense
design using a spreadsheet editor.

While most of your work will be done using Designer view (the default plate view), you can
select other views by clicking the Plate View Type button from the toolbar at the top.

Volume Fill Types

The Volume Fill Type button displays a list that shows you different options for how to
vary the volume across a selected area. The default setting is Constant Volume, but you
can select either Horizontal Gradient, Vertical Gradient, Forward Diagonal Gradient,
Backward Diagonal Gradient, Checkerboard 1, Checkerboard 2, Backfill, or Scale.

Plate Designer

Plate View
Type

Volume Fill
Types

Copy
Selected Zoom InRedo

Clear All
Wells

Fit All Wells
with Volumes

Paste
Selected

Undo Zoom Out Fit All
Wells

Open
Spreadsheet

Plate Designer Toolbar Buttons
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The MANTIS software provides you with several options to select multiple wells using
different patterns, to speed up the dispense design process. This can be especially useful
when using plates with large numbers of wells. There are 13 different patterns available in
the MANTIS software. A blue box surrounding the icon indicates that a selection pattern is
active, while inactive patterns do not have a blue box. You may use more than one pattern
at a time, according to your needs. When you have applied a selection pattern, you can
easily define the volume for the selected well(s) by either typing a volume or by using the
available dispense designs.

The status bar, located at the bottom of the MANTIS software, gives you up-to-date
information about what's going on with your MANTIS. If you have the LC3 hardware, the
indicator box for the instrument will automatically appear. The status bar is divided into
several sections, as shown below.

The icons in the indicator box vary depend on the MANTIS hardware models used by user.
The indicator box will appear as either green, yellow, or red. If the indicator box is green,
the MANTIS software is connected to the MANTIS hardware. Yellow means that you are
operating in simulation mode, which means any actions taken in the software will not affect
the hardware. Red means that the software is not connected to the hardware.

The RFID Status Indicator appears green when the MANTIS is equipped with RFID and the
RFID reader is ready.

Tip: You can enter simulation mode by clicking the indicator box.

Important: If the RFID status indicator appears red, it means that there is an
error on the reader. Report this issue by emailing support@formulatrix.com.

Status Bar

Well Selection Patterns

The Well Selection Patterns

Status Bar
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To set up the MANTIS for a dispense:

1. Insert the High Volume (HV), Low Volume (LV), High Volume PFE, Low Volume
PFE, or Continuous Flow (CF) chip into the chip pallet.

Setting Up the Hardware
Chapter 8

PFE Chip LV Chip

Tube Input Adapter

Magnetic Chip Pallet

HV Chip

Chip Assembly
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If you are dispensing to deep well blocks, you will need pressurized bottles and
continuous flow chips. You will also need to calibrate the reagents for continuous
flow use.

● Insert the tubes into the holes in the CF chip.

● Tighten the screw in the CF chip by using a 1.5 mm screwdriver.

2. Put the chip pallets into the chip port stations.

3. Attach the reagent tubes or pipette tips to the ingredient input at each chip. Skip
this step if you are using CF chips.

● If you are using a pipette tip, you will need to remove the black adapter from
the chip’s input.
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Note: It is recommended to cut your input tubing to a length of 45 cm for
High Volume and Low Volume chips.

Installing a Continuous Flow Chip

Putting the Chip into the Chip Port
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4. Place your plate on the plate holder using the alignment pins to guide it into
place.

5. Fill the wash container(s) with distilled water and/or wash solution (if you are
using wash solution, you must follow the wash solution with a water rinse). Make
sure that the wash container(s) contain enough water or wash solution and they
are properly placed in the wash stations located at the back sides of the MANTIS.

6. Make sure that the waste container is installed in the waste station.

7. Proceed to the next step in the dispense process, designing a dispense with the
software.
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Note: Acceptable wash solutions include: Low molar (~0.1N) NaOH, 10% bleach,
or 70% ethanol. If you are running 3-step Wash, wash solutions should go in
Wash Station 2, on the right side of the MANTIS with the two chip stations.
Otherwise, it can go on Wash Station 1. See also Wash Step(s) on page 39.

The MANTIS v3 with a Microplate and Pipette
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Once you have set up the hardware, you will use the MANTIS control software to either
open a dispense list or design a dispense.

Prerequisites

● You have at least one plate type already set up in the software.

To design a dispense:

1. Choose from the following options:

● Create a new dispense list: Click the New Dispense List button . Select a

plate type and click OK.

OR

● Open an existing dispense list: Click the Open Dispense List button . Find

your dispense list and click Open, then proceed to step 5.

2. Add a reagent to the dispense list. Define the Reagent Name and Dispense
Location and click OK.  If you want to add additional reagents, click Add More.

Dispensing With the MANTIS
Chapter 9

Note: You can skip these steps if you have loaded experiment designs
from FORMULATOR.

Add More Option

Designing a Dispense
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3. Begin designing your plate dispense with the plate designer:

● Click and drag your mouse over a group of wells to select them, or select a
pattern from the Selection group under the plate designer.

● For a constant volume, type in a volume and press Enter on your keyboard.

● To use a gradient design, click the small down arrow next to the grid

button . You may choose a horizontal gradient, a vertical gradient, a
forward diagonal gradient, a backward diagonal gradient, checkerboard 1, or
checkerboard 2.

● To use a checkerboard dispense pattern, click the small down arrow next to

the grid button . You may choose checkerboard 1 or checkerboard 2.

● To add a backfill volume, click the small down arrow next to the grid button,

and then click the backfill volume button .

4. Click the Single Update Input button next to each reagent input. Select
the Chip Type (Low Volume, High Volume, High Volume PFE, Low Volume PFE, or
High Volume Continuous Flow chip), and type the Prime Volume (optional),
Primary Wash Volume, Secondary Wash Volume (optional), Recovery Volume,
and Pre-Dispense Volume. See Default Volume and Tubing Length
Recommendation on page 28.

5.   Drag the reagent name from the Dispense List to either the text box next to the chip
position, or the chip position on the image of the MANTIS.

OR

Click the Assign To Input button to assign all reagents from the Dispense
List at once.

Drag Reagent to the Device Control Panel

Assign a Dispense List of Reagents to Chip
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Once you have set up the hardware, you will use the MANTIS control software to either open
a dispense list or design a dispense.

Prerequisites

● You have at least one plate type already set up in the software.

To design a dispense:

1. Choose from the following options:

● Create a new dispense list: Click the New Dispense List button . Select a

plate type and click OK.

OR

● Open an existing dispense list: Click the Open Dispense List button . Find

your dispense list and click Open, then proceed to step 5.

2. Add a reagent to the dispense list. Define the Reagent Name and Dispense
Location and click OK.  If you want to add additional reagents, click Add More.

3. Begin designing your plate dispense with the plate designer:

● Click and drag your mouse over a group of wells to select them. or select a
pattern from the Selection group under the plate designer.

● For a constant volume, type in a volume and press Enter on your keyboard.

● To use a gradient design, click the small down arrow next to the grid

button . You may choose a horizontal gradient, a vertical gradient, a
forward diagonal gradient, a backward diagonal gradient, checkerboard 1, or
checkerboard 2.

● To use a checkerboard dispense pattern, click the small down arrow next to the

grid button . You may choose checkerboard 1 or checkerboard 2.

● To add a backfill volume, click the small down arrow next to the grid button,
and then click the backfill volume button.

4. Click the Single Update Input button next to each reagent input. Select
the Chip Type (Low Volume, High Volume, High Volume PFE, Low Volume PFE, or
High Volume Continuous Flow chip), and type the Prime Volume (optional), Primary
Wash Volume, Secondary Wash Volume (optional), Recovery Volume, and Pre-
Dispense Volume. See Default Volume and Tubing Length Recommendation on
page 28.

Designing a Multi-Plate Dispense

Note: If the dispense list has more reagents than the amount of the chip stations,
the Assign To Input button will not work. The amount of reagents should be less
or same as the number of chip stations.

Note: You can skip these steps if you have loaded experiment designs
from FORMULATOR.
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5. Drag the reagent name from the Dispense List to either the text box next to the chip
position, or the chip position on the image of the MANTIS.

OR

Click the Assign To Input button to assign all reagents from the Dispense List
at once.

6. On the Dispense Setting tab, type the amount of plates you want to dispense in the
Number of Plates field.

Note: If the dispense list has more reagents than the amount of the chip stations,
the Assign To Input button will not work. The amount of reagents should be less
or same as the number of chip stations.

Drag Reagent to the Device Control Panel

Assign a Dispense List of Reagents to Chip

Number of Plates Option
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The MANTIS is capable of dispensing reagents with viscosities up to approximately 10 cP
without requiring custom software settings. Working with reagents with viscosities above
10 cP can cause hanging drops as well as inaccurate dispense volume and coefficient of
variation (CV). To prevent those issues, both the pressure and timing settings need to be
adjusted when dispensing reagents with viscosities of around 15 cP (see the list of
reagents below).

List of reagents with viscosities approaching to 15 cP (20 oC):

1. PEG 1000, 40%

2. PEG 3350, 28%

3. PEG 4000, 25%

4. PEG 8000, 18%

5. Glycerol, 60%

Adjusting pressure for high viscosity reagent dispensing

You can slightly increase the pressure and vacuum applied to the diaphragms when using
the diaphragm chips, and you can increase the bottle pressure when using the continuous
flow (CF) chip.

1. Go to the Tools menu and select Reagent List.

2. Select a reagent in the Reagent Name column and click the HV Continuous Flow
tab.

3. Click Show Advanced Options.

4. Adjust the diaphragm pressure and vacuum as well as the CF bottle pressure, as
follows:

● For diaphragm dispensing, increase the Pressure Chip and Vacuum
values until your desired results are achieved.

● For continuous flow dispensing, increase the Pressure Bottle value until
your desired results are achieved.

Viscous Dispensing Tips and Tricks

Note: These settings will not be as effective with PFE chips.

Note: Pressure settings can only be applied to MANTIS V3 and later. Proceed to “Timing”
if you are using a V2 MANTIS.

Important: DO NOT exceed 18 psi for Pressure Chip or -18 inHg
for Vacuum.

Tips: Using a pipette input is better for viscous dispensing.

Important: DO NOT exceed 10 psi for the Pressure Bottle. Note that by
increasing the Pressure Bottle above the default value, a warning
message will show up. This can be ignored as long as you do not
exceed 10 psi bottle pressure.

Note: You should recalibrate the CF whenever you change the
Pressure Bottle.
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Adjusting diaphragm timing for high viscosity reagent dispensing

One way to improve accuracies and CVs for higher viscosity reagent dispensing is by
running the diaphragm chips at a slower rate. By doing so, you will achieve a more
complete filling and emptying of the diaphragms. Slow the timing on the chip by telling
the software that your standard LV or HV silicone chip is actually an LV or HV PFE chip.
There are two ways to change your chip types:

1. For changing the chip types in all or more than one input items:

a. Go to the Input Control panel and click the Mass Update Input

button .

b. Select Low Volume PFE or High Volume PFE from the Chip Type list
accordingly.

c. Click Apply.

2. To change the chip types individually:

a. Click the Input button next to every reagent name box.

b. Select Low Volume PFE or High Volume PFE from the Chip Type list
accordingly.

c. Click OK.

Low Volume PFE and High Volume PFE Chips

Low Volume PFE and High Volume PFE Chips
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Prerequisites

● You have created a dispense list.

Delay Between Reagents

To add a dispense delay to a dispense list:

1. Click a dispense list item to select it.

2. Click the Add Delay button .

3. Click the Delay row to configure the delay settings.

4. Go to the bottom of the dispense list designer and
choose a Delay Type (UserInput or Timer).

5. Optional: If you selected Timer, type the number of seconds in the Delay Time
(s) field. You can also leave a message in the Message box to be displayed
when the dispense delay is running.

Delay Between Wells

To add a dispense delay between wells:

● Type the desired number of seconds for the delay in the Delay Between Wells
(s) option in the bottom part of the dispense list designer.

You can use Microsoft Excel or OpenOffice to view and edit your experiment data if
you prefer that method over a visually-oriented designer.

Prerequisites

● You have loaded a dispense list to the Dispense List Designer.

To edit a dispense list with Excel or OpenOffice:

1. Click the Excel editor button  on the right area of the Dispense List

Designer. A lock button will appear on the dispense list, and the Excel or
OpenOffice editor will display the dispense list items and their volumes.

2. Edit the volumes manually. If you are trying to create a new dispense
design based on an existing spreadsheet, you can now copy and paste
the dispense volume data from the existing spreadsheet to the MANTIS-
formatted spreadsheet. Your volumes must be in microliters (μL).

Adding a Dispense Delay

Using Excel to Edit a Dispense Design
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Note: By default, the MANTIS will automatically turn off the pump for any
dispense delay lasting for longer than five minutes. To disable this feature,
please set the Disable Pump for long delay value in the Advanced Options to
False. If you want to modify the default time, contact FORMULATRIX support
for help.

Adding a Dispense Delay

Note: If you attempt to edit a dispense design in Excel, any reagents left with
zero volume will be removed from your dispense list when you save your
changes and return to the MANTIS software.

mailto:support@formulatrix.com
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3. Save the changes in Excel, or click the X in the upper-right corner to exit Excel. If
you click the X, you will be asked if you want to save your changes. Click Yes.

4. Please be patient while MANTIS reads your changes and renders them in the
MANTIS software. Once the conversion is complete, your dispense list is
unlocked and you may interact with your design in the MANTIS Designer View.

The MANTIS software enables you to create and load dispense protocols. Using dispense
protocols can help you work faster and more efficiently, particularly if you frequently use
the same hardware setup or plate design. Protocols essentially tie together a reagent
configuration file and a dispense list (more information on reagent configuration and
dispense lists can be found in Creating and Using Reagent Configurations on page 55). If
your protocol was created by importing an external dispense data in .CSV format, the
protocol will be also linked to the .CSV file, allowing you to reload your dispense data from
an updated .CSV file.

To create a protocol:

1. Design a plate dispense and assign each reagent to a chip as normal. See
Designing a Dispense on page 47.

2. Go to the File menu, point to Protocols and then select Save.

3. Browse the file directory where you want to save your files.

4. Type a name for the protocol in the File Name box, click Save, and then click Yes
when the confirmation message appears.

You have successfully created your protocol. Please note that you can open an existing
dispense list and create a protocol from that point of the guide. To load the protocol for
future use, follow the steps below.

To load a protocol:

1. Go to the File menu, point to the Protocols menu, and then select Load.

2. If you do not find your protocol files, click the Browse button next to the
Current Path box and locate your protocol files.

3. Select the protocol from the list in the Select Protocol box.

4. Optional: You can select or deselect the Reload volume data from .CSV option if
you have previously imported the dispense list protocol from the Importing
Dispense Data menu. This option will load the dispense data found in the .CSV file,
disregarding any changes previously made in MANTIS.

5. Click Load Files if you want to load both the hardware setup and the dispense
design.
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Creating and Using Protocols

Note: If you have not yet saved the dispense list and/or the reagent configuration
files, you will be prompted to do so before you can save the protocol.

Note: If you would like to revert a previously imported dispense to its original
reagent and volume data, see Reloading Dispense Data on page 68.
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A Reagent Configuration enables you to save, load, and modify the hardware setup for each
of your reagents. This configuration contains all of the reagent settings and information that
you might need for any future dispense process.

To create and use a reagent configuration:

1. In the Input Control Panel, type a reagent name in the Reagent Name box.

OR

You can drag and drop the reagent to each reagent input from the dispense list.
See Designing a Dispense on page 47.

2. Choose one of the options below:

● Click the Input button Input button next to each reagent input.

● Click the Configure All Input Settings button .

● Go to the Tools menu, point to the Reagent Configuration, and then select
Setting.

3. Select the Input Source Type, either Tube or Pipette Tip.

4. Select the Chip Type accordingly: Low Volume, High Volume, High Volume PFE,
Low Volume PFE, or High Volume Continuous Flow chip.

5. Type the Prime Volume (optional), Pre-Dispense Volume, Recovery Volume, and
the wash volume if you enable the Wash Step(s) option. See Default Volume and
Tubing Length Recommendation on page 28.

6. When you have finished, click OK.

Creating and Using Reagent Configurations

Input Setting Window

Note: If you are using the All Input Settings window, please locate your
input number carefully before proceeding to the next step.
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7. Go to the File menu, point to Reagent Configuration, and then select Save.

8. Browse the file directory where you want to save your files.

9. Type a name for the reagent configuration in the File Name box and click Save.

10. To load the reagent configuration in the future, go to the File menu, point to the
Reagent Configuration menu, and then select Load.

11. If you do not find your reagent configuration files, click the Browse

button next to the Current Path box and locate your reagent configuration
files.

12. Select the reagent configuration from the list in the Select Reagent Configuration
box.

13. Click OK if you want to load the reagent configuration.

It's important to prime the chips before every dispense to ensure that the reagent has
moved through the chip to the dispense point, so that you are dispensing liquid and not air.
At this point, you should have already designed a dispense (or opened an existing
dispense).

Prerequisites

● You have set up the hardware.

● You have designed a dispense.

To prime all of the chips:

● Click the Prime All Inputs button  if you want the MANTIS to prime each chip
attached to the MANTIS.

To prime an individual chip:

1. If you want to prime an individual chip, right-click on the reagent in the Device
Control panel and select Attach Input to Hand.

2. Click the Manual Prime button  if you don’t know how much reagent you

need to dispense in order to prime the chip. Once you see a drop of reagent come
out of the bottom of the chip, the chip is primed.

OR

Click the Auto Prime button  if you want to prime the chip with the fixed prime

amount (as defined in the input options menu).

You are now ready to execute the dispense!

Priming the Chips

Note: Click Save As if you want to save an existing reagent configuration
to a different file name and/or directory.
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To dispense a plate design:

● Click the Run Dispense button  .

OR

Press F5.

When the dispense finishes, if you are not planning to dispense more than one plate, you
can run reagent recovery to conserve reagent volume (optional), or proceed directly to
washing the chips.

If you're running multi-plate dispensing, the Change Plate Dialog will appear. You can
either continue the dispense or abort it. If you want to continue, place your next plate on
the plate holder and click Continue. Click Stop to abort the dispense.

MANTIS now enables you to see which reagent or well is currently dispensing on the Plate
Designer. Each active well on the Plate Designer will flash and highlight during the
dispense. When the dispensing process is accidentally stopped or paused, the software
will save the last well position so that you can easily restart the dispense from where it left
off.

To enable this feature, please follow these steps:

1. On the Tools menu, click Options.

2. Click the Advanced Options tab and locate the Dispense options.

3. On the Use Dispense Visualization option, select True to activate the dispense
indicator. To deactivate the setting, select False.
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Executing a Plate Dispense

Change Plate Dialog
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4. Click OK to apply the changes.

The reagent recovery process forces reagent out of the chip into the input tube or pipette
tip. Run Reagent Recovery when you want to conserve reagent volume.

Prerequisites

● You have executed a plate dispense.

To recover reagent volume from all inputs:

● Click the Recover All Inputs button .

To recover reagent volume from individual inputs:

● Right-click on a reagent in the Device Control panel and select Attach Input to
Hand.

● Click the Recover Input button .
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Recovering Excess Reagent Volume

Note: For the Continuous Flow (CF) chips, you can determine the recovery duration,
enable the double recovery setting, and determine the delay time between two
recoveries. For more information, see Input Control Panel on page 35.

Important: We recommend that you wash the chips after each use, please
see Cleaning the Chips on page 73 for further details.

Dispense Indicator
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If you have externally generated experiment designs saved as .CSV files, (either volume or
concentration data) you can easily load them into MANTIS software using the Import
Dispense Data feature. Currently there are two supporte layouts: Well Name Based and
Reagent Name Based. MANTIS will convert your .CSV file into a dispense list and allow you
to edit each of the experiment parameters, if necessary. When you have finished editing
the parameters, you can save your work as a protocol to be used for future dispenses.
Protocols generated from .CSV files even allow reloading of updated data after saving.

In this section, you will learn how to import your .CSV file for dispense using the MANTIS.
The two options for the .CSV file format are:

1. Well Name Based format defines the dispense information with data arranged in
rows, with one row per well/reagent combination. This allows omitting
well/reagent combinations with 0 for target volume. Click to learn more about
Importing the experiment design data from a Well Name Based .CSV file on page
60.

2. Reagent Name Based format defines what reagents are to be dispensed and in
what amounts without referencing specific well names. A Reagent Name Based
file arranges its data in columns, with one reagent per column and one row per
well. Click to learn more about Importing the experiment design data from the
Reagent Name Based .CSV file on page 63.
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Importing Dispense Data

Well Name Based Example shown in Microsoft Excel

Reagent Name Based Example shown in Microsoft
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Importing the experiment design data from a Well Name Based .CSV file

To import the dispense data from a Well Name Based file:

1. Go to the File menu, and select Import Dispense Data on the Import Dispense
Data menu.

2. Select Well Name Based and click Next.

3. Click the Browse button next to the Input File box and locate the file you
want to import.

Selecting the Well Name Based file

Modifying the File Settings
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4. In the File Settings option:

● The Column Delimiter determines the separator between values in the .CSV
file. Type the separator used in your file.

● If your .CSV file has a header and the column names are in the first row,
select the Column Names are in the first row box. If not, deselect the option.

● Select or type the row number you want to start importing data from in the
Start Row box (typically the first data row).

5. In the Target Plate option, select the plate type you want to use for dispense
from the plate list and then click Next.

6. Select from one of the options below:

● Concentration Data: If your current data is a list of concentration values,
select this option to convert it to volume, and then proceed to step 7.

● Volume (μL) Data: If your current data is a list of volumes in μL, select this
option and proceed to step 8.

7. Input the Total Well Volume (μL) and the stock concentration values of each
reagent, then hit the Enter key on your keyboard to apply the values. The
Converted Data table will display the updated volumes in microliters (μL). Click
Next to select the chip type for your reagents.

Note: If one or more items in the converted data are highlighted in red, the stock
concentration is not suitable for delivering one or more of the well volumes without
overfilling the well(s). Adjust the stock concentration value and try again.

Data Preview Options
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8. Click the Chip Type drop-down list and select the desired chip type (Low Volume,
High Volume, or Continuous Flow) that you want to use. The table columns to help
you make an informed choice:

● Target Volume: The result calculated by the concentration to volume
converter.

● Actual Volume: The actual volume that can be achieved with the selected chip.

● % offset: The difference between the Target Volume and the Actual Volume,
expressed as a percentage.

9. Click Next to select chip types for the other reagents and the diluent. When you are
done selecting the chip types for all reagents, click Next.

10. To save your settings as a protocol, type a descriptive name in the Protocol Name
box. Your new protocol will be added to the MANTIS Protocol List database, which
you can access from the Load option under the File and Protocols menus. To learn
more about protocols, see Creating and Using Protocol on page 54.
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Note: For Continuous Flow chip, when the target volume is lower than 5 μL, the
actual volume will display the error volume in red. For more information, see the
FORMULATRIX Chip Specification.

Select Chip Type Options

Note: You can also select the Suggest Chip Type option on the right corner of the
Converted Data (μL) panel, which enables MANTIS to suggest a chip type for each
reagent, based on the volume data, while maximizing speed and minimizing error.

Note: You will not be able to modify a saved protocol from the Import Dispense
Data wizard if you re-open it after you close the MANTIS software.

http://www.formulatrix.com/liquid-handling/products/mantis/index.html#main=spec
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11. Then, click the Load button to load the data into a Dispense List.

12. OPTIONAL: Go to the File menu, and select Import Dispense Data if you are not
satisfied with the way your current your experiment was imported. The software will
remember the choices you have made during the import process and allow you to
modify them as necessary. This option is applicable only if you have not restarted
the MANTIS software.

13. Click the Run Dispense button .

OR

Press F5.

Importing the experiment design data from the Reagent Name Based .CSV file

To import the dispense data from a Reagent Name Based file:

1. Go to the File menu, and select Import Dispense Data on the Import Dispense
Data menu.

2. Select Reagent Name Based and click Next.
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Selecting the Reagent Name Based

Note: If you choose a Continuous Flow chip and you have not calibrated your
reagents, the MANTIS Continuous Flow calibration window will appear after you
click the Load button. Follow the on-screen instructions to calibrate your chips. For
more information, see Calibrating Continuous Flow Chips on page 27.
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3. Click the Browse button next to the Input File box and locate the file you
want to import.

4. In the File Settings option:

● The Column Delimiter determines the separator between values in the .CSV
file. Type the separator used in your file.

● If your reagent names are in the first row, select the Reagent Names are in
the first row box. If not, deselect the option.

● Select or type the row number you want to start with in the Start Row box.

5. In the Target Plate option:

● Select the plate type you want to use for dispense from the plate list.

● Determine the well numbering convention by selecting either the Well
number increments by Row: A1, A2, A3 or by Column A1, B1, C1 option.

q Well increments by Row: A1, A2, A3 means that the wells in your plate
design are numbered left-to-right in rows. For example, wells A1 through
A12 are numbered 1 to 12 and are represented by the first 12 data rows of
your .CSV file. Wells B1 through B12 are numbered 13 to 24 and so on.
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Modifying the File Settings

Well number incrementing by Row
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q Well increments by Column: A1, B1, C1 means the wells in your plate
design are numbered top-to-bottom in columns. For example, wells A1
through H1 are numbered 1 to 8 and are represented by the first 8 data
rows of your .CSV file. Wells the next column A2 through H2 are
numbered 9 to 16 well, and so on.

6. OPTIONAL: To change your reagent's name, click on the reagent box and type a
new reagent name.

7. You can select one or several reagent data columns to be imported from the
.CSV by checking the boxes above the columns in the table. To select all
reagents at once, check the Select all columns box at the upper-right corner of
the table. Click Next to proceed.

8. Select from one of the options below:

● Concentration Data: If your current data is a list of concentration values,
select this option to convert it to volume, and then proceed to step 9.
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Note: You cannot proceed to the next step until you have selected one or several
reagents in the Select data columns to be imported table. You can always go back
to this table to modify your reagent selection if you haven’t closed the Import
Dispense Data wizard.

Well number incrementing by Column

Selecting all reagents at once
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● Volume (μL) Data: If your current data is a list of volumes in μL, select this
option and proceed to step 10.

9. Input the Total Well Volume (μL) and the stock concentration values of each
reagent, then hit the Enter key on your keyboard to apply the values. The
Converted Data table will display the updated volumes in microliters (μL). Click
Next to select the chip type for your reagents.
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Note: If one or more items in the converted data are highlighted in red, the stock
concentration is not suitable for delivering one or more of the well volumes without
overfilling the well(s). Adjust the stock concentration value and try again.

Data Preview Options

Concentration - Volume Converter



67

10. Click the Chip Type drop-down list and select the desired chip type (Low
Volume, High Volume, or Continuous Flow) that you want to use. The table
columns to help you make an informed choice:

● Target Volume: The result calculated by the concentration to volume
converter.

● Actual Volume: The actual volume that can be achieved with the selected
chip.

● % offset: The difference between the Target Volume and the Actual Volume,
expressed as a percentage.

11. Click Next to select chip types for the other reagents and the diluent. When you
are done selecting the chip types for all reagents, click Next.

12. To save your settings as a protocol, type a descriptive name in the Protocol
Name box. Your new protocol will be added to the MANTIS Protocol List
database, which you can access from the Load option under the File and
Protocols menus.

Note: For Continuous Flow chip, when the target volume is lower than 5 μL, the
actual volume will display the error volume in red. For more information, see the
FORMULATRIX Chip Specification.

Note: You can also select the Suggest Chip Type option on the right corner of the
Converted Data (μL) panel, which enables MANTIS to suggest a chip type for each
reagent, based on the volume data, while maximizing speed and minimizing error.

Note: You will not be able to modify a saved protocol from the Import Dispense
Data wizard if you re-open it after you close the MANTIS software.

Select Chip Type options
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13. Then, click the Load button to load the data into a Dispense List.

14. OPTIONAL: Go to the File menu, and select Import Dispense Data if you are not
satisfied with the way your current experiment was imported. The software will
remember the choices you have made during the import process and allow you
to modify them as necessary. This option is applicable only if you have not
restarted the MANTIS software.

15. Click the Run Dispense button .

OR

Press F5.

If you created a dispense list by importing external data via a CSV file, the Reload
Dispense Data option enables you to reload the updated dispense data from the .CSV file
into the dispense list.

To reload the dispense data into the dispense list:

1. Go to the File menu, point to Import Dispense Data and select Reload Dispense
Data.

2. On the warning message, click Yes if you want to overwrite the currently open
dispense list data. Please note that this does not automatically save the updated
dispense list.

OR

Click No to abort the process.

Note: If you choose a Continuous Flow chip and you have not calibrated your
reagents, the MANTIS Continuous Flow calibration window will appear after you
click the Load button. Follow the on-screen instructions to calibrate your chips.
For more information, see Calibrating Continuous Flow Chips on page 27.

Reloading Dispense Data

Note: You may not change the names of the reagents listed in the original .CSV file.
Otherwise, MANTIS will not reload it into the dispense list due to the mismatch.
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Reload Dispense Data
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MANTIS can normalize liquid concentrations, by calculating and dispensing the necessary
diluent volume for each well to ensure that every well has the same concentration. If you
have concentration data saved in a .CSV file, such as the output data from
CONSTELLATION® Digital PCR System, you can easily upload the .CSV into MANTIS to
create a dispense list. Then you can use MANTIS to dispense the desired diluent into your
experiment plate. Follow the instructions below to normalize your concentration data.

Prerequisites

● You have a .CSV file containing concentration data for the plate you wish to normalize.

● You have placed your experiment plate on the plate holder.

To normalize your concentration data:

1. Go to the File menu and select Concentration Normalization.

2. Click the Browse button next to the Input File box and locate the file you want
to import.

3. In the File Settings option:

● The Column Delimiter determines the separator between values in the .CSV file.
Type the separator used in your file.

● If your reagent names are in the first row, select the Reagent names are in the first
row box. If not, deselect the option.

● Select or type the row number you want to start with in the Start Row box.

Normalizing Concentration

The Concentration Normalization Option

Modifying the File Settings

MANTIS User's Guide  |  Chapter 9: Dispensing With the MANTIS



70

4. In the Target Plate option:

● Select the plate type you want to use for dispense from the plate list.

● Determine the well numbering convention by selecting either the Well
number increments by Row: A1, A2, A3 or by Column A1, B1, C1 option.

q Well increments by Row: A1, A2, A3 means that the wells in your plate
design are numbered left-to-right in rows. For example, wells A1 through
A12 are numbered 1 to 12 and are represented by the first 12 data rows of
your .CSV file. Wells B1 through B12 are numbered 13 to 24 and so on.

q Well increments by Column: A1, B1, C1 means the wells in your plate
design are numbered top-to-bottom in columns. For example, wells A1
through H1 are numbered 1 to 8 and are represented by the first 8 data
rows of your .CSV file. Wells the next column A2 through H2 are
numbered 9 to 16 well, and so on.

5. Select the concentration data that you want to import in the data columns list. Then,
click Next.

6. Determine the value in the Data Preview:

● Specified Concentration: By default, the Specified Concentration value is taken
from the well with the lowest concentration. You can also set a different target
concentration value by typing the desired value in the box. Any wells with
concentration lower than the Specified Concentration will be excluded from
the normalization process.

Well Number Incrementing by Row

Well Number Incrementing by Column
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Note: If the data column contains error(s), you will not be able to select the column.
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● Well Capacity: Determines the maximum well volume for your plate.

● Starting Volume: Determines the concentration volume of each well in your
experiment plate, before normalization.

Note: You cannot continue to the next step if your current settings cause diluent
volume overflow, which is shown in red in the bottom right of the wizard. To fix this,
you can adjust either the Specified Concentration value or the Well Capacity value
until no overflow is detected. Well Capacity as defined in the MANTIS software
should not exceed the actual maximum well volume for your plate.

Modifying the Plate Data

The Overflow Diluent Volume in Red
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7. Click Next to proceed.

8. Type the Diluent name in the Diluent Name box and click the Load button to load the
data into a Dispense List.

9. OPTIONAL: Go to the File menu, and select Concentration Normalization if you are not
satisfied with the way your current experiment was imported. The software will
remember the choices you have made during the import process and allow you to
modify them as necessary. This option is applicable only if you have not restarted the
MANTIS software.

10. Click the Run Dispense button .

OR

Press F5.

Type the Diluent Name
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It’s important to clean the chips after each use to prevent cross-contamination and the
formation of dried reagent buildup. Before you begin, remove any reagent tubes from the
reagent bottles and direct them to a waste container.

If you are running 3-step Wash, wash solutions should go in Wash Station 2, on the right
side of the MANTIS with the two chip stations. Otherwise, it can go on Wash Station 1. See
also Wash Step(s) on page 39.

Prerequisites

● You have executed a plate dispense.

● You have set up the wash solution.

● You have put the input tubes into a waste container.

To clean all diaphragm chips:

● To wash all inputs at once, click the Wash All button .

To clean an individual diaphragm chip:

1. To wash individual inputs, right-click a reagent on the Device Control panel and

select Attach Input to Hand, then click the Wash Input button .

2. Repeat the wash process on each input until you can no longer see reagent
leaving the chip in the reagent tube.

3. Repeat the wash process on each input until you can no longer see reagent
leaving the chip in the attached tube.

4. You may want to run the Reagent Recovery process a second time to ensure the
inside of the chip is dry.

To clean a Continuous Flow chip:

1. Remove the Continuous Flow cap from your reagent bottle and screw it onto a
different reagent bottle containing your wash solution.

2. Attach the chip to the MANTIS hand.

3. Click the Prime Input button .

Note: If you are using a pipette tip, you will need to remove the black
adapter from the chip’s input.

Cleaning the Chips
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MANTIS can be integrated with ROCK MAKER to dispense a plate design you've created in
ROCK MAKER.

Prerequisites

● You have configured MANTIS-ROCK MAKER integration. For more information,
please see Configuring MANTIS-ROCK MAKER Integration on page 101.

● You have used ROCK MAKER to create an experiment (if you haven't and you
need help, please see the ROCK MAKER help files for assistance).

To run ROCK MAKER experiments with MANTIS:

1. Place the MANTIS chips into the chip pallets, and attach the chip pallet to a chip
changer station.

2. Attach the reagent tubes or pipette tips to the ingredient inputs at each chip.

3. Place the microplate on the plate holder. The microplate you use should be the
same one you selected in ROCK MAKER.

4. Go to the Tools menu and select Hand Scan.

5. Type your experiment barcode number next to Data to scan (you only need to
type the last four digits). If MANTIS successfully reads and validates the barcode,
your dispense list, design and settings will display.

6. Drag the reagents from the Dispense List Designer panel to the corresponding
inputs.

7. Click to start the dispense or click to run dispense with protocol. The
MANTIS will complete your plate dispense design.

8. OPTIONAL: If you want to conserve reagent volume, run Reagent Recovery.

9. When you're finished dispensing, clean the chips. For more information, please
see Cleaning the Chips page 73.

Dispensing ROCK MAKER® Crystallization Software Plate Designs

Note: If you are using a pipette tip, you will need to remove the black adapter
from the chip’s input.
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The Hand Scan Dialog

Note: The dispense list imported from ROCK MAKER is configurable after
import, however any changes will not be reflected in ROCK MAKER.
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If your lab is equipped with both the FORMULATOR and MANTIS, the two liquid handlers
can be integrated so that non-precious reagents are dispensed with the FORMULATOR,
and precious reagents are dispensed with the MANTIS.

Prerequisites

● You have configured MANTIS-FORMULATOR integration. For more Information,
please see Configuring MANTIS-FORMULATOR Integration page 104.

● You have sent reagents from the FORMULATOR software to the MANTIS
software.

● The plate definition names are the same in MANTIS as they are in FORMULATOR.

● If you are dispensing some reagents with the FORMULATOR, you have already
performed this part of the process.

To run FORMULATOR experiment designs with MANTIS:

1. Place the MANTIS chips into the chip pallets.

2. Attach the reagent tubes or pipette tips to the ingredient inputs at each chip.

3. Place the microplate on the plate holder.

4. Drag the reagents from the Dispense List Designer panel to the corresponding
inputs.

5. Attach your reagents to the MANTIS chips (if you are using pipette tips, you will
need to remove the black adapter from the chip’s input first).

Dispensing FORMULATOR® Screen Builder Plate Designs

Note: If you are using a pipette tip, you will need to remove the black adapter
from the chip’s input.
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Drag Reagent to the Device Control
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6. Click to start the dispense or click to run dispense with protocol.

7. The MANTIS will complete your plate dispense design. You may now run
Reagent Recovery (optional). When you're finished dispensing, please clean the
chips.

You can perform a factory reset if you find corrupted data, experience an unexpected
software- or hardware-related error, or accidentally change the MANTIS configuration
data. Resetting the MANTIS software will revert it back to the software version that was
first installed on your MANTIS system. The user data, such as dispense lists, dispense
summaries, plate definitions, protocols, and reagent configurations will be preserved.
Follow the steps below to reset the MANTIS software.

Prerequisites

● You have closed the MANTIS software.

● You have the Factory Data folder that contains all of the required files on your
MANTIS USB drive (i.e. Usb Drive:\MANTIS\Data\Factory Data).

To perform the factory reset:

1. Go to Usb Drive:\MANTIS\Bin.

2. Locate Mantis.FactoryReset.exe.

3. Double-click the file. The console application window appears on your screen.

Performing a MANTIS Factory Reset

Note:  If you do not have the folder, contact our support by emailing
us at support@formulatrix.com.
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The MANTIS Factory Reset Application

The MANTIS Factory Reset Application

mailto:support@formulatrix.com
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4. Type y on the console app window and then press Enter on your keyboard to
reset the MANTIS software.

5. After the factory reset process is finished, type y and hit Enter on your keyboard
to restart the MANTIS software.

If you see a red exclamation point icon next to a reagent on your dispense list, it means
that there is a problem with your dispense list item. In many cases, mousing over the
exclamation point will display text that explains how to resolve the issue.

For example, in the scenario below, you would resolve the issue by dragging the reagent
to its location on the input control panel.

Resolving Dispense List Errors
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A Successful MANTIS Factory Reset

Dispense List Errors
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Using the Options Menu

You will notice that there are two tabs: Options and Advanced Options. Advanced Options
should be used by support technicians only. Please do not alter the options under the
Advanced Options tab unless you are directed by FORMULATRIX support to do so.

Options

This section covers the following topics:

● Dispense Settings

● Wash Settings

Dispense Settings

See the table below for detailed explanations of each option found in the Dispense area.

Wash Settings

See the table below for detailed explanations of each option found in the Wash area.

Option Default Setting Description

Detach Last
Dispensed Chip

True
Determines whether or not MANTIS detaches
and returns the last dispensed chip to its port
after the dispense process completes.

Dispense Path Horizontal
Determines the arms movement direction when
executing a dispense.

Pre-dispense and
Prime with SD

Pump
False

Set this option to True if you want to use only the
small diaphragm pump for pre-dispense and
prime processes. This can help preserve
reagents, but may increase the time needed for
these processes to be completed.

Recover Reagents
Before Detach

True

Determines whether or not MANTIS performs
reagent recovery before detaching and returning
the chip to its port. Reagent recovery can prevent
reagent from siphoning out of the chip when it is
in the chip port.

Option Default Setting Description

Reagent Recovery
After Wash

False

Determines whether or not MANTIS performs
the reagent recovery after washing the chips. If
you use MANTIS infrequently, you should set
this to True.

Wash After
Dispense

Disable

Determines whether or not MANTIS washes the
chips after the dispense process completes. If
set to Ingredient, MANTIS will automatically
wash the chips after each reagent. If set to
Plate, MANTIS will automatically wash the chips
when a plate dispense finishes.
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Advanced Options

This section covers the following topics:

● Application Settings

● Arms Settings

● Dispense Settings

● Dispense Summary Settings

● Hand Settings

● Integration Service (IS) Settings

● Manual Arms Control Settings

● RFID Settings

● Security Settings

● Stage Settings

● Support Settings

Unless you are completely confident about the changes you are about to make, you
should not edit the following settings without guidance from FORMULATRIX support.

If you need a simple refresher, however, use the tables in each drop-down topic below to
help you understand and configure the various options.

Application Settings

See the table below for detailed explanations of each option found in the Application area.

Arms Settings

See the table below for detailed explanations of each option found in the Arms area.

Important: These settings are for advanced users only! Doing something incorrectly
here may render your system inoperable. Consult with FORMULATRIX support if
you have any questions.

Option Default Setting Description

Show Deck
Geometry

Correction Menu
False

Set this option to True to display the Deck
Geometry Correction menu.

Option Default Setting Description

Attach Detach
Status

Disable

Set this option to Enable to enable the MANTIS
attach and detach status check. When enabled,
the air pump will be used to ensure whether the
chip is properly attached to or detached from
the MANTIS hand.

Home Stage Motors
During Picking Chip

Before and After
Determines when to home the stage motors
while picking up the chip.

mailto:support@formulatrix.com
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Dispense Settings

See the table below for detailed explanations of each option found in the Dispense area.

Dispense Summary Settings

See the table below for detailed explanations of each option found in the Dispense
Summary area.

Hand Settings

See the table below for detailed explanations of each option found in the Hand area.

Option Default Setting Description

Disable Pump for
Long Delay

True
Enables MANTIS to automatically turn off the
pump for long delay. Set this option to False to
disable this feature.

First Dispense
Diaphragm

Small
Determines which diaphragm is to be dispensed
first.

Update Sequence
Editor During

Dispense
False

Set this option to True to enable updates to the
Sequence Editor during dispense.

Use Dispense
Visualization

True
Set this option to False to deactivate the
dispense indicator.

Waste Station
Location

Default

Default: The waste station is in the default
location. See Hardware Overview on page 10.

Adapter: The waste station is set at the back of
MANTIS (for LC3 only). See Setting Up the LC3
for a Dispense on page 91.

Option Description

Theta Motor 1
Offset

Allows you to realign the theta motor 1 position in case its position
goes wrong when homing. To adjust the value, press Alt+F2 on
the keyboard, then set it manually via the Theta Motor Control
Pad. The up arrow increases the value, and the down arrow
decreases it. The speed slider determines how fast the changes
will occur.

Theta Motor 2
Offset

Allows you to realign the theta motor 2 position in case its position
goes wrong when homing. To adjust the value, press Alt+F2 on
the keyboard, then set it manually via the Theta Motor Control
Pad. The up arrow increases the value, and the down arrow
decreases it. The speed slider determines how fast the changes
will occur.

Option Default Setting Description

Enable Dispense
Summary

False

Set this option to True to enable the MANTIS
software to create a dispense summary log file.
This file will be created once per day as long as
this option is enabled.
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Integration Service (IS) Settings

See the table below for detailed explanations of each option found in the Integration
Service (IS) Setting area.

Manual Arms Control Settings

See the table below for detailed explanations of each option found in the Manual Arms
Control area.

RFID Settings

See the table below for detailed explanations of each option found in the RFID area.

Option Default Setting Description

Integration Service
Base Address

The API Service host address.

Service Remote
Start

Deny

Determines the setting for the integration
service to run as a background process.

● Allow — Allows the MANTIS IS to be
remotely started or stopped from different
computers.

● Deny — Denies remote access to the
MANTIS IS.

● Ask — Asks you to allow or deny remote
access to the MANTIS IS.

Option Default Setting Description

X Axis Manual Control

Acceleration: 2500

Determines the X Axis acceleration
and velocity values for the motion
controller.

Velocity Fast: 20

Velocity Normal: 10

Velocity Slow: 1

Y Axis Manual Control

Acceleration: 2500

Determines the Y Axis acceleration
and velocity values for the motion
controller.

Velocity Fast: 20

Velocity Normal: 10

Velocity Slow: 1

Z Axis Manual Control

Acceleration: 500

Determines the Z Axis acceleration
and velocity values for the motion
controller.

Velocity Fast: 20

Velocity Normal: 5

Velocity Slow: 1

Option Default Setting Description

Rescan Input on
Arm Before

Dispense
False

Set this option to True to enable MANTIS to
always rescan the RFID chip attached to the
MANTIS arm before dispense.

Scan Inputs During
Startup

True
Set this option to False to disable RFID chips
scanning during startup.
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Security Settings

See the table below for detailed explanations of each option found in the Security area.

Stage Settings

See the table below for detailed explanations of each option found in the Stage area.

Support Settings

See the table below for detailed explanations of each option found in the Support area.

Option Description

Stage offset in X Axis The stage offset values in X axis to solve any sloping positions.

Stage offset in Y Axis The stage offset values in Y axis to solve any sloping positions.

Stage origin Original stage position, which can be used as reference values.

Option Default Setting Description

Password
protected settings

False
Set this option to True to activate the security
mode. See Using the Security Settings on
page 83.

Backup email
address*

Determines the email address for the
security backup.

Password* Determines the security password used.

Option Description

Attach Log Files Enables the system to send zipped log files via email.

Is Notify Immediately
Determines whether the system will automatically send an
email notification to FORMULATRIX team support, in the event
of an error.

Mail From
The email address from which the error notification will be
sent.

Mail To The email address to which the error notification will be sent.

Number of Log Files to
Attach

Determines how many log files will be attached in an email.

SMTP Enable SSL Enables you to choose if your SMTP server supports SSL.

*This option is available if you set the Password protected settings option to True.
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Option Description

SMTP Password Determines the SMTP password used.

SMPTP Port
Determines the SMTP port number associated with your email
address.

SMPTP Server
Determines the SMTP server associated with your email
address.

SMPTP UserName
Determines the SMTP user name associated with your email
address.
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Using the Security Settings

If you are an administrator, you can manage the MANTIS access modes through the
Security settings. Other than the default mode, there are two access modes available:
administrator and general user. In the administrator mode, the administrator can create or
modify dispense settings and has the ability to lock these settings. Then, the general users
will access the general user mode, mainly for opening a dispense list, setting reagent to
inputs, and running the dispense. All other settings are locked in general user mode.

Section 1: Configuring the access settings

You need to configure the access settings before you can activate the security settings. In
these settings, you are required to fill in a password to login to the administrator mode,
provide a backup email address in case you forget your password, and provide the Simple
Mail Transfer Protocol (SMTP) server details. You can typically obtain that information from
your institution’s IT knowledgebase, or directly from a network administrator.

To configure your access settings:

1. Go to the Tools menu and select Options.

2. Click the Advanced Options tab.

3. Locate and select the Security section.

4. Set the Password protected settings to True.
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5. Type the desired Backup email address and Password.

6. If you have finished, locate and select the Support section.

7. Configure the SMTP options as appropriate for your IT setup. For more information
about these options, see Support Settings on page 82.

8. If you have finished, click OK.

Note: At this point, you have only set the configuration access settings. If you
want to activate the security option, please proceed to Section 2: Activating the
security option below.
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Security Options

Support Options
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Section 2: Activating the security option

This section explains how administrators can activate and deactivate the security option to
manage the access modes. Activating the security option will enable the Security menu,
where you can switch between the administrator and general user modes. You have to
configure the access settings before activating the security option.

To activate the security option:

1. Go to the Tools menu and select Options.

2. Click the Advanced Options tab.

3. Locate and select the Security option.

4. To activate the security option, select True on the Password protected settings.

5. Click OK to save your changes.

Section 3: Locking and unlocking the dispense settings

This section explains how an administrator can lock and unlock the dispense settings for
switching the access modes. You are required to activate the security option in the
Advanced Options tab. If you activate the security option, the Security menu will appear
after you save the settings.

Note: At this point, you have only activated the security option. Proceed
to Lock the Security Settngs to lock the dispense settings.
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Activating the security option

Security Settings Menu
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To lock the security setting:

1. Go to the Security menu and then click Lock.

2. If you have locked the security settings, you are now using the general user
mode. In this mode, the user will only have access to open a dispense list, to set
reagents to inputs, and to run a dispense.

To unlock the security setting:

1. Go to the Security menu and then click Unlock.

2. Type the password and click OK.

Note: If you forgot the password, click Forgot Password? MANTIS will reset
your password and send an email to your backup email address.

MANTIS User's Guide  |  Chapter 9: Dispensing With the MANTIS

Locking the Dispense

General User Mode
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3. At this point, you will return to the administrator mode.

Section 4: Deactivating the security option

This section explains how administrators can deactivate the security option to manage the
access modes. Deactivating the security option will disable the Security menu and
deactivate the administrator and general user modes.

To deactivate the security option:

1. Go to the Tools menu and select Options.

2. Click the Advanced Options tab.

3. Locate and select the Security option.

4. To deactivate the security option, select False on the Password protected
settings.

5. Click OK to save your changes.
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Administrator Mode

Deactivating the Security Option
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Large Capacity Chip
Changer (LC3)
Chapter 10

LC3 Components

LC3 The LC3 is the base for the chip changer carousel. It has several
components such as power ports, USB ports, and a barcode
scanner
Port.

Carousel The chip changer carousel consists of chip stations and tube
holders.
There are two types of carousels, with 24-chip or 18-chip capacity.

LC3 FRONT

LC3 Front View
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Tube Holder Depending on the type of LC3 carousel you use, the tube
holder is compatible with either 15 mL Falcon tubes or 50
mL Falcon tubes.

Chip Station The chip stations are compatible with High Volume (HV),
Low Volume (LV), High Volume PFE, Low Volume PFE, and
High Volume Continuous Flow (CF) chips.

Power Switch The power switch turns the LC3 on and off.

Power Ports There are two power ports, one for connecting the LC3 to
the MANTIS — as the MANTIS can power itself off of the LC3
— and one for connecting the LC3 to a power outlet.

Barcode Scanner
Port

The barcode scanner port is used for connecting the LC3 to
a barcode scanner. Please note that the barcode scanner is
optional.

USB Ports There are four USB ports, three Type A and one Type B. The
Type B port is used for connecting the LC3 to your MANTIS.
The other three can be used for USB flash drives.

LC3 BACK

LC3 Back View
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Locating Plate The function of the locating plate is to align the LC3 with
the MANTIS.

There are three different locating plates: Left, Right, and
Right-Left. The locating plate shipped with your MANTIS
depends on your specific order.

Locating Plate

Locating Plates
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Prerequisites

● You have the LC3 option, along with the carousel and a locating plate.

● You are familiar with the component names of the LC3 hardware (see LC3 Components
on page 88).

To set up the LC3 for a dispense:

1. Locate the MANTIS on the center of locating plate by lining up the pin slots under the
MANTIS base to the locating plate’s pins.

2. Locate the LC3 to the pins on the locating plate by lining up the pin slots under the LC3
base to the locating plate’s pins.

3. Position the carousel on top of the LC3.

4. Put the MANTIS chips into the chip stations.

5. Attach the reagent tubes in the tube holders or pipette tips to the inputs at each chip.

Setting Up the LC3 for a Dispense

An Example of the Hardware Setup Using Left Locating

Left Locating Plate

Pins for LC3 Hardware Pins for
MANTIS

Hardware

The Center of the
Locating Plate
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You must calibrate the LC3 before initial use and whenever the MANTIS fails to pick up and
return a chip from a chip station on the LC3.

LC3 calibration requires two processes, tuning the “locked” position and tuning the
“unlocked” position. The “locked” position is the position of the chip when the MANTIS picks
up a chip from a chip station. “Unlocked” refers to the chip position when the MANTIS
returns the chip to the chip station.

Prerequisites:

● The MANTIS is connected to the LC3, and the LC3 and MANTIS indicators on the
status bar are green.

● The chip must be placed in the chip station labeled ‘1’ on the carousel that you wish
to tune and you have removed the chip from the MANTIS hand.

To Tune the LC3

1. Go to the Chip Changer menu and select Tuning.

2. Select from the options below:

● If the LC3 carousel is at the left of the MANTIS, click L1 on the Image of the LC3
carousel. In the example below, the LC3 carousel is positioned at the left of the
MANTIS.

● If the LC3 carousel is at the right of the MANTIS, click R1 on the image of the
LC3 carousel. The image you see will differ from the example image below.

Tuning the LC3 Carousel
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6. Put your plate on the MANTIS plate holder.

7. Fill the wash container(s) with distilled water or wash solution (if you are using wash
solution, you must follow the wash solution with a water rinse). Make sure that the wash
container(s) are properly placed in the wash stations located at the back sides of the
MANTIS.

MANTIS With a 24-Chip Carousel
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3. Click Next and follow the on-screen instructions.

● If you have previously configured your carousel, select a carousel name from
the available list on the bottom-left of the Auto Chip Changer Tuning window.

Click the Rename button  to change a carousel name, and click the

Delete button  to remove an existing carousel from the list.

● If you would like to tune a new carousel, select New Carousel, select the
carousel type from the Carousel Type list, and then type a name for your
carousel.

4. Click Next.

5. In the first three steps of this wizard, you will configure the “locked” position of the
chip. Stand up and look down at the MANTIS. Using the motion controls, align the
edges of the metal MANTIS arm with the walls of the chip station.

6. Position the MANTIS hand so that the front point of the chip is directly above the
front point of the chip pallet.

7. Use the motion controls to tweak the position of the arms and hand as necessary.
Lower the hand into the chip station until the magnet picks up the chip, making
sure that the arms remain parallel to the ground and are not flexed in an upward or
downward position.

OR

You can also use the keyboard keys to control the motion:

● W: The key moves the MANTIS arms backward along the Y Axis.

● S: The key moves the MANTIS arms forward along the Y Axis.

● A: The key moves the MANTIS arms left along the X Axis.

● D: The key moves the MANTIS arms right along the X Axis.

● R: The key moves the MANTIS arms upward along the Z Axis.

● F: The key moves the MANTIS arms downward along the Z Axis.

● Q: The key rotates the left carousel clockwise.

● Z: The key rotates the left carousel counterclockwise.

● E: The key rotates the right carousel clockwise.

● C: The key rotates the right carousel counterclockwise.

8. You will now configure the “unlocked” position. Remove the chip from the chip
pallet, and attach it to the MANTIS hand.

9. Align the metal MANTIS arm with the walls of the chip station. Then, position the
hand above the chip station, this time aligning the tabs on the chip pallet with the
indents at the edge of the chip station.

10. Lower the chip into the chip station, being careful to keep the arms of the MANTIS
parallel with the ground. If the position is correct, the MANTIS will leave the chip in
the chip station.
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11. Test pick-up and drop-off for both chip positions to ensure the new settings are
correct.

12. If you are satisfied, click Finish. Otherwise, click Re-tune to re-tune the chip position.

13. Optional: Click Tune Next to tune another chip position or another carousel.
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Test the Chip Position Settings

Note: If you have the 18 chip carousel, you can test for position 1 and
position 10. If you have the 24 chip carousel, you can test for position 1 and
position 13.
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MANTIS Radio-Frequency
Identification (RFID)
Chapter 11

This MANTIS option uses a Radio-Frequency Identification (RFID) tag installed in each chip
to provide helpful information about the chip usage and dispense process. The MANTIS
instrument with RFID is fitted with six antennas for a faster RFID tag reading/writing
process.

RFID Reader

Chip Changers with
RFID Tag Readers

RFID Tag

LC3 Carousel with RFID Reader
MANTIS RFID

MANTIS Chip with an RFID Tag
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The following basic information is stored on each RFID chip itself:

After each dispense using an RFID chip, the following information will be stored directly
onto your MANTIS database, tagged to the serial number of that chip.

Option Description

Chip Type E.g. High Volume, Low Volume, PFE, or Continuous
Flow.

Total Volume Dispensed Total volume that this chip has dispensed to date.

Small Diaphragm Cycle Total number of Small Diaphragm cycles to date.

Large Diaphragm Cycle Total number of Large Diaphragm cycles to date.

Date of Manufacture This chip’s manufacturing date.

Chip Serial Number This chip's unique ID.

Option Description

Dispense Date Dispensing process date.

Protocol Name Name of the protocol used for the dispensing process.

Dispense List Name Name of the dispense list used for the dispensing process.

Plate Type Plate type used for the dispensing process.

Reagent Name Name of the reagent used during the dispensing process.

Chip Position Number Chip station number in the Chip Changer or LC3 Carousel.

Input Type Input source type, such as tube or pipette.

Total Volume Dispensed Total volume that this chip has dispensed to date.

Small Diaphragm Cycle Total number of Small Diaphragm cycles to date.

Large Diaphragm Cycle Total number of Large Diaphragm cycles to date.

Fill Cycle Total number of Fill Diaphragm cycles to date.

Output Cycle Total number of Output Diaphragm cycles to date.

Dispense Status Status of a dispensing process, whether it is finished or
interrupted.

Dispense History
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If your MANTIS includes Radio-Frequency Identification (RFID) functionality, you can use
the RFID to access the history of a chip, such as chip usage and dispense information. In
this tutorial, you will learn how to scan RFID chips (either all chips or an individual chip) and
open the chip dispense history.

Prerequisites:

● You have MANTIS which supports RFID.
● You have set up the hardware. See Setting Up the MANTIS on page 44.

Scanning RFID Chips

Scanning RFID chips during Startup

MANTIS now supports automatic RFID scanning during startup. This feature is useful for
you to get the most up to date chip information, especially after setting up new hardware.
To enable or disable this feature, follow these steps:

1. On the Tools menu, click Options.

2. Click the Advanced Options tab and locate the RFID option.

3. On the Scan Inputs During Startup option, select True to activate RFID chip
scanning during startup. To deactivate the scanning, select False.

4. Click OK to apply the changes.

Option Description

Prime Volume Volume used for the priming process.

Pre-Dispense Volume Volume used for the pre-dispensing process.

Primary Wash Volume Volume used for the primary wash process.

Secondary Wash Volume Volume used for the secondary wash process.

Recovery Volume Volume used for the recovery process.

Wash After Dispense Wash behavior after the dispensing process. There are three
kinds of behaviors:

● Plate: The washing process is done after the plate
dispensing process.

● Reagent: The washing process is done after a reagent
has been dispensed.

● Disabled: The washing process is done after a dispense
process is disabled.

Chip Pressure Chip pressure value.

Bottle Pressure Bottle pressure value.

Chip Vacuum Chip vacuum value.

Wash Pressure Wash pressure value.

Wash Vacuum Wash vacuum value.

Prime Pressure Prime pressure value

Recovery Pressure Recovery pressure value.

Recovery Vacuum Recovery vacuum value.

Using the RFID Functionality in MANTIS
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Scanning RFID chips manually

You can scan your RFID chip(s) in two different ways: either by scanning all chips at once
or scanning an individual chip.

To scan all chips:

● Click the Scan All RFID Chip Inputs button  in the Input Control Panel for

instant scanning.
OR

1. Go to the Tools menu, select Scan Inputs for RFID chips.

2. Click Start Scan in the Scan MANTIS Inputs window.

● This icon indicates that the RFID chip is available.

● MANTIS will tell you if an RFID chip is not available
during the scanning process. To overcome this, please check whether you
are using an RFID chip or not. If not, replace the chip with the desired RFID
chip and try again. If you are already using an RFID chip but it is undetected,
please contact support@formulatrix.com.

3. Select Apply to apply the scanning result to the MANTIS inputs and then click Yes
when the confirmation message appears.

OR

Select Cancel if you want to cancel applying the scanning result to the MANTIS
inputs.

RFID Scanning

mailto:support@formulatrix.com.


99

MANTIS User's Guide  |  Chapter 11: MANTIS Radio-Frequency Identification (RFID)

To scan an individual chip:

● Click the Scan RFID Chip button on the desired Input box for instant scanning.

OR

1. Click the Input button in the Input Control Panel.

2. Select the Scan Chip button  in the Chip Serial Number box. You can also

clear the input scanning result by clicking the Clear RFID Input button .

3. When the scanning process is finished, click OK.

Individual Chip Scanning with Scan RFID Button

Individual Chip Scanning

Input Option Window
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Opening the Chip Dispense History

Besides scanning the RFID chips, you can also open the chip dispense history to review the
chip usage and dispense information.

Prerequisites:

● The RFID chip has been dispensed before.

To open the chip dispense history:

1. Click the Input button .

2. Go to Chip Dispense History tab.

3. To export the chip dispense history, click the Export All to File

button.

4. Change the file name if desired.

5. Click Save, and then click OK.

6. To close the window, click OK.

Dispense History Window
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MANTIS Configuration
Chapter 12

There are some basic settings you need to configure if you want to be able to dispense
ROCK MAKER plate designs with MANTIS.

Prerequisites

● You are running MANTIS 2.3 or newer.

● You are running ROCK MAKER 2.0 or newer.

Step 1: Set up ROCK MAKER – MANTIS Integration

1. Open Mantis.exe.config in the MANTIS directory, where the MANTIS software is
installed.

2. Specify the user setting location in this key <add key= “UserSettings.Location”
value to create the Extension folder and check that the settings in this key <add
key=”Common.SharedFiles.Entries” value is same with the Shared folder location
of Rock Maker.

3. When you’re done, point to the File menu and click Save to save your changes.

Configuring MANTIS-ROCK MAKER
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Step 2: Test MANTIS – ROCK MAKER Integration

1. Open the ROCK MAKER software and create a new experiment:

a. From the tree, right-click a project or a folder within a project and select New
Experiment.

b. Rename the experiment by typing over the default name on the Explorer. Try
to be as descriptive as possible.

c. Fill in the fields on the Experiment tab such as Plate type.

d. Go to the Canvas tab and make a new grid layer consisting of ingredients and
protein.

e. Save your changes by selecting Save from the File menu. The experiment
barcode displays in the Explorer tree.

New Experiment in ROCK MAKER

ROCK MAKER Canvas

ROCK MAKER Explorer
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f. Point to Dispensing folder, right-click Run Queue and select Dispense
Properties.

g. Select the Plates tab and change the plate-specific properties based on the
plate type used in your experiment.

h. Next, go to the FORMULATOR: Plate definition file name column. You need
to get the exact name of the plate definition file name from the MANTIS
directory, so open the MANTIS directory and go to
MANTIS\Data\User\Plates.

i. Click OK to confirm.

2. In the MANTIS software, point to the Tools menu and click Hand Scan (Ctrl+H).

3. Type your experiment barcode number in the Data to scan box (you only need to
type the last four digits). If MANTIS successfully reads and validates the barcode,
your dispense list, design and settings will display.

MANTIS User's Guide  |  Chapter 12: MANTIS Configuration

Dispensing Folder in ROCK MAKER

Dispensing Properties

Hand Scan
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There are some basic settings you need to configure if you want to be able to dispense
FORMULATOR experiment designs with the MANTIS.

To access these settings, go to the Tools menu and select Options. You may need
assistance from your network administrator to configure these settings correctly if you are
running MANTIS and FORMULATOR on different computers.

Prerequisites

● You are running MANTIS 2.3.2 or newer.

● You are running FORMULATOR 1.15 or newer.

Step 1: Configure MANTIS-FORMULATOR Integration with the MANTIS Software

1. Go to the Tools menu and select Options.

2. Set Start IS Remotely to ALLOW, ASK or DENY:

● ALLOW — FORMULATOR has full permission at all times to send dispense
lists to the MANTIS.

● ASK — A notification will appear on the computer that runs the MANTIS. You
must grant permission each time the FORMULATOR wants to send a
dispense list to the MANTIS.

● DENY — The FORMULATOR will NOT be allowed to send dispense lists to the
MANTIS.

3. Verify that the plates you plan to use have the same name in MANTIS as in
FORMULATOR:

● On the Tools menu, click Microplate Editor. A dialog box opens.

● On the File menu, click Open.

● Navigate to the plate definition files for the plates you plan to use in your
experiments. Verify that it is exactly the same name as in the FORMULATOR's
microplate definition library. (In FORMULATOR's Advanced View, point to the
File menu and click Open, then select Microplate Definition and find the
plate definition.)

Step 2: Configure MANTIS-FORMULATOR integration with the FORMULATOR Software

1. On the Tools menu, click Options.

2. Click the MANTIS tab and perform the following actions:

a. Select the Enable MANTIS Integration check box.

b. Next to Server, type in the server information. If MANTIS and FORMULATOR
are running on the same computer, type localhost.

c. Next to Port, leave the default setting (7091) unless your system administrator
instructs you to enter another port.

Configuring MANTIS-FORMULATOR

MANTIS User's Guide  |  Chapter 12: MANTIS Configuration
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d. Next to Shared Folder, click and select a folder that both MANTIS and
FORMULATOR have access to. If you are running MANTIS and FORMULATOR
on the same computer, any folder will work.

e. Click the blue Test MANTIS Integration Service link to test the settings. The
MANTIS software must be running for MANTIS integration settings to work.

The MANTIS Tab in FORMULATOR
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Deck Geometry Correction
Chapter 13

If the MANTIS is dispensing drops that aren’t aligning with your plate drop locations, you
may need to tune the MANTIS dispense location settings using the Drop Alignment Wizard
and the reference plate.

In the instructions that follow, you will learn how to tune four points on the MANTIS plate
holder: A1, A12, H1, and H12. The MANTIS then interpolates these locations to determine
each remaining drop location on a plate.

Prerequisites

● You have the reference plate that was included in the MANTIS accessory kit.

● You have either a Low Volume or High Volume chip.

● You have a pipette tip filled with colored water.

● You have enabled the Deck Geometry Correction Menu option.

Correcting the Deck Geometry:

1. Attach a chip to the MANTIS hand.

2. Place the pipette tip in the pipette tip input on the chip.

Important: This instruction is intended for advanced users only! Doing something
incorrectly here may render your system inoperable. Consult with FORMULATRIX support
if you have any questions.

mailto:support@formulatrix.com
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3. Prepare the reference plate. The reference plate has cross hairs located in every
corner that can be used as reference points (see the picture below, indicated by
four red circles).

4. Place the reference plate on the MANTIS plate holder. Use the A1 location
(indicated by the red circle) as the reference point.

5. On the Tools menu, click Deck Geometry Correction.

6. Follow the on-screen instructions.

MANTIS User's Guide  |  Chapter 13: Deck Geometry Correction

Reference Plate

A1 Location
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System Maintenance
Chapter 14

You can sterilize the MANTIS chips if your application requires aseptic handling, if you are
concerned about biological growth or cross-contamination when using the same chip for
different reagents, or if you are planning to leave the chips unused for a few days or more.

f your reagent is likely to precipitate, you should consider running a wash cycle
immediately following the dispense and prior to the sanitization, to avoid clogging.

The acceptable sterilization reagents in order of preference is:

1. 70% ethanol

2. 0.5% sodium hypochlorite (10% commercial chlorine-based bleach)

3. 0.1 M NaOH

4. Detergent-based cleaners, such as Lysol and Microsol.

To Sterilize the MANTIS Chip(s):

1. Empty wash station 1 and wash station 2. Fill wash station 1 with water and fill
wash station 2 with one of the approved sanitizing solutions.

Sterilizing MANTIS Chips

Important: Sterilization may involve using harsh chemicals. Please use proper safety
equipment at all times when operating the MANTIS. FORMULATRIX is not responsible for
personal injuries incurred due to a lack of or improper use of personal protection equipment.
If you would like to use a different sanitizing reagent, please consult the chemical
compatibility chart and/or contact support@formulatrix.com. Using incompatible reagents
can damage the MANTIS and void the product warranty. FORMULATRIX is not responsible
in whole or in part for any damages caused by failure to comply with the procedures
outlined in this document.

Important: To avoid ruining your sample, you need to completely remove the
sterilizing/cleaning agents before you use the chips.

http://www.formulatrix.com/chemical_compatibility.html
http://www.formulatrix.com/chemical_compatibility.html
mailto:support@formulatrix.com
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2. Place the MANTIS chip(s) into the chip port(s) on the chip changer.

3. Attach an input tube to every chip and put the other end of the tube into a waste
container (e.g. a 50 mL tube on the chip changer).

4. Click the Input button next to each chip you plan to sterilize.

5. Locate the Wash Step(s) and select the 3 (Station 1-2-1) option.

6. Type the volumes for Wash Volume 1 (Station 1), Wash Volume 2 (Station 2), and
Wash Volume 3 (Station 1). Please use reasonably large volumes (300-500 μL) to
ensure every chip gets washed. The first chip may receive lower wash volumes
due the priming of the wash stations. Please note that the last wash step is
necessary to rinse the chip from the sanitizing reagent and should not be omitted.

7. When you have finished, click OK to save your input settings.

8. Click the Wash All Available Inputs button to wash every assigned chip with
the sterilization solution and rinse them with water.

9. OPTIONAL: If you are using bleach or hydroxide as your sterilizing agent, follow
the steps below for the reagent neutralization or inactivation process:

a. Empty wash station 2 and fill it with a buffer of your choice to neutralize
the hydroxide, or sodium thiosulfate to inactivate the bleach.

b. Click the Wash All Available Inputs button  on MANTIS to wash
every assigned chip with the solution and rinse them with water.

10. To dry the chips, click the Recover All Inputs button .

Note: You can adapt these instructions to wash an individual chip. To do so, make the
MANTIS pick up the chip to be washed and click the Wash Input on MANTIS Arms

button followed by the Recover Input on MANTIS Arms button .

Input Control Panel

Note: It is recommended to neutralize or inactivate your sterilization agent
if you want to use your chips immediately after sterilization or if you are
dispensing sensitive material, such as live cells.

MANTIS User's Guide  |  Chapter 14: System Maintenance
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Troubleshooting and
FAQs
Chapter 15

Troubleshooting

While the MANTIS is designed to be a reliable device, as with all hardware, problems
may occur with use or over time. If you don't see your problem below, email
support@formulatrix.com for assistance. Our technicians monitor this email address 24
hours a day, Monday through Friday.

The MANTIS is dispensing incorrect volumes or not dispensing at all, regardless the
chips or the input source types being used.

One possible cause for inaccurate dispense volumes is a stuck solenoid. If you
experience this, you should check the solenoids by running the Stuck Solenoid Check
wizard.

To check the solenoids:

1. Go to the Tools menu and select Stuck Solenoid Check.

2. At this point, MANTIS will perform the Stuck Solenoid Check. After the test is
finished, the results will be displayed in the Stuck Solenoid Check window.

Important: Make sure that there is no chip attached to the MANTIS before
performing the test.

Checking for Stuck Solenoid The Red Cross Icon Indicates the Solenoid may be Stuck

mailto:support@formulatrix.com
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3. If MANTIS suspects one or more solenoids of being stuck, the Solenoid Check
Confirmation window will appear. The Solenoid Check Confirmation process
allows you to confirm whether or not a solenoid is truly stuck. Click Expected
Sound to listen to what a solenoid valve should sound like when it opens and
closes.

4. Click Check to listen to the sound of the solenoid suspected of being stuck.

5. Compare the expected sound with the good solenoid sound from your
hardware.

a. Click Yes if the sound from the tested solenoid is similar to the sound
you hear when you click Expected Sound. This means that the
solenoid works properly.

b. Click No if you do not hear any sound from the hardware. If you do
not hear anything, the solenoid is not working properly. Report this
issue by emailing support@formulatrix.com and a support
representative will have your MANTIS repaired as quickly as possible.

6. Close the wizard.

MANTIS is dispensing incorrect volumes when using PFE/HV chips, or MANTIS is
not dispensing accurately from a pipette tip.

Incorrect dispense volumes may occur if the chip type in use is different from the chip
type selected in the MANTIS software. Check that the chip type selected in the
software is correct; if not, select the correct chip type. See Input Control Panel on page
35 for modifying and selecting your chip types correctly.

MANTIS cannot aspirate reagents from a tube, or MANTIS can aspirate but the
dispense volume is not accurate.

Check the tube connection and make sure it is firmly attached to the chip/tube input.
If you see either if these issues after the first dispense or after the chip returns in
between reagents, then make sure you are priming the chip before each dispense.
Failure to prime a chip will prevent accurate dispenses. Please also note that it takes
approximately 150-200 µL to prime the chip for the first dispense.

Note: The green check icon indicates that there is not stuck. The red cross

icon indicates that the solenoid is suspected to be stuck.

Solenoid Check Warning
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MANTIS is not dispensing correctly — drops are hanging at the end of the nozzle,
dispenses are sporadic (i.e. the MANTIS dispenses to every other well instead of
every well), or the MANTIS is not dispensing at all.

Sometimes the chips wear out. We recommend that you try dispensing with multiple
chips. If the problem persists, contact support by emailing support@formulatrix.com. If
you are on maintenance, you will be shipped a loaner MANTIS, instructed to ship yours
to support for repairs, and when you receive the repaired device you must ship back the
loaner.

The MANTIS is having trouble washing chips.

Usually this issue is caused by a misalignment of the wash position. To fix this problem,
you will need to edit the sequence file. Contact support by emailing
support@formulatrix.com and a support representative will walk you through the
process.

My computer says the drive is read-only and I can't run the software.

If your computer is showing that the MANTIS USB drive is read-only, you will not be able
to use the software because the software frequently writes to the USB drive. To fix this
issue, copy the contents of the USB drive onto your computer, so that when you run the
software you are running it locally instead of from the USB drive. Or if you are on
maintenance, you can contact support by emailing support@formulatrix.com to get a
replacement drive.

MANTIS is not showing up on my computer's drive list, or I can run the software but
the software can't find the MANTIS.

These problems are caused by USB communication issues. Please contact support by
emailing support@formulatrix.com. If you are on maintenance, they will issue a loaner
device to use while yours is repaired.

MANTIS is not picking up chips from the chip port, or it's picking up chips but not
replacing them correctly.

This issue can be fixed by calibrating the chip port positions.

MANTIS is dispensing drops, but the drops aren't aligned with the wells on my plate.

● Make sure that you have accurately registered your plate definition in the Plate
Type Library. For more information, see Adding Plate Types to the Plate Type
Library on page 14.

● If the plate definition has been accurately entered but the problem persists, you can
fix the deck geometry settings. Go to the Tools menu and select Deck Geometry
Correction, then follow the on-screen instructions. For more information, see Deck
Geometry Correction. For assistance using the Deck Geometry Correction Wizard,
contact support by emailing support@formulatrix.com.

The MANTIS software seems frozen.

● If you are attempting to open or close the dispense design using a spreadsheet
program such as Microsoft Excel, it can take a few moments for the software to
translate your actions. Please be patient.

● Check that you are not in Summary View or Volume Error View. These two
views will "freeze" the rest of the interface. Switch back to Designer View in
order to enable the rest of the software's functionality. To change views, click
the button at the top of the plate designer to display the alternative views.

mailto:support@formulatrix.com
mailto:support@formulatrix.com
mailto:support@formulatrix.com
mailto:support@formulatrix.com
mailto:support@formulatrix.com
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You see liquid in the Air Ribbon.

In the case liquid being spilled on top of the chip, the liquid can enter the MANTIS Air
Ribbon when the chip is being picked up or dropped off. Liquid can also enter the Air
Ribbon if a chip fails catastrophically (diaphragm or valve rupture). If you ever notice
liquid droplets in the Air Ribbon, you must purge the liquid to prevent it from entering
the solenoid bank and damaging the MANTIS hardware. Follow these instructions to
purge liquid from the Air Ribbon.

To purge liquid from the Air Ribbon:

1. In the Tools menu, select Purging Tool.

2. Click Start to begin the purging process.

Air Ribbon at the Back of the MANTIS Arms

Starting the Purging Process

The MANTIS Software Seems Frozen
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3. The default time for the purging process is five minutes. If the liquid is
completely gone from the Air Ribbon in less than five minutes, click Stop to
end the process.

4. Optional: Repeat steps 1 and 2 if there is still liquid in the Air Ribbon, until it
has all been purged.

5. Click the Cancel or Close button when you are finished, or to abort the
process and close the Purging Tool wizard.

If your question doesn't appear below, please email support@formulatrix.com and we will
respond within 24 hours, Monday through Friday.

What should I do if the mantis software doesn’t recognize the device?

Please take these steps:

1. Turn the MANTIS device off.

2. Reconnect the USB cable on the MANTIS USB port to your computer. Make
sure it is connected properly, and then restart the device.

3. Next, run the software; the indicator box should be green after it has detected
the device.

4. If the problem persists, please check your hardware version and don’t
hesitate to contact FORMULATRIX support.

What viscosities or liquid classes can the MANTIS dispense?

The MANTIS can dispense normal liquid class to reagents with high viscosities. For
more information, see Viscous Dispensing Tips and Tricks on page 51.

Stopping the Purging Process

FAQs
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Items Description

Chips (Low Volume Chips, High
Volume Chips, Low Volume
PFE Chips, High Volume PFE
Chips, High Volume CF Chips,
Low Volume Molecular Grade
chips, High Volume Molecular
Grade Chips)

Four extra nozzles and tube adapters are included in the package. High Volume
chips are indicated by a green input.

Chips with RFID tags
Chips with Radio-Frequency Identification (RFID) tags store chips' information and
dispense history. These are only available for MANTIS with RFID option.

Chip Pallets
The chip pallets enable microfluidic chip replacement. Compatible with both low
volume and high volume chips.

MANTIS Chip Changers The MANTIS chip changers are used to hold chip pallets when not in use.

Extra Nozzles (LV And HV
Nozzles)

The MANTIS nozzle is installed in the chip.

Abrasion-Resistant Teflon Input
Tubing – Green (for High
Volume Chips) and Clear (for
Low Volume Chips)

The tubing is used for connecting ingredient(s) from its source to the chip(s).

Reference Plate
The reference plate is a clear plate that has crosshairs located at each corner. The
crosshairs are targets for you to use if you need to tune drop position. The MANTIS
software then determines the remaining drop positions from these four points.

Ball Point Hex Keys
Also known as Allen wrenches, ball point hex keys are included for troubleshooting
purposes.

Power Cable
The power cable is approximately 6 feet long, and is used to conduct power to your
MANTIS from the power supply adapter.

Accessories
Appendix A

MANTIS User's Guide  |  Accessories
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Items Description

USB Cable The USB cable connects the MANTIS to a PC.

Waste and Wash Tube
The waste tube is a container to remove spent washing fluid. The wash tube is a
container to hold water or other washing solutions required for washing process.

Power Supply Adapter
The power supply adapter supplies power and connects to an electrical outlet and
the MANTIS power cable.

Food Coloring Food coloring is included for test dispense purposes.

MANTIS User's Guide  |  Accessories
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